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Foreword

THIS MANUAL IS CONFIDENTIAL AND A PROPRIETARY TRADE SECRET OF GRAYMETA, INC.
COPYRIGHT 2024.

THIS INFORMATION MAY NOT BE COPIED OR DISTRIBUTED WITHOUT EXPRESS PRIOR
WRITTEN PERMISSION.

Limitation on Warranties and Liability

This document neither extends nor creates warranties of any nature, expressed or implied.
GrayMeta, Inc. cannot accept any responsibility for your use of the information in this document or
for your use of any associated software program. GrayMeta, Inc. assumes no responsibility for any
data corruption or erasure as a result of the use of the information in this document, or the use of
software programs. You should be careful to ensure that your use of the information complies with
all applicable laws, rules, and regulations of the jurisdictions with respect to which the information is
used.

Information in this document is subject to change without notice or obligation.

Copyright © GrayMeta, Inc. 2024.

Acknowledgements & Licensing

Manufactured under license from Dolby Laboratories. Dolby, Dolby Vision, Dolby Atmos, Dolby
Audio and the double-D symbol are registered trademarks of Dolby Laboratories Licensing
Corporation. Confidential unpublished works. Copyright © 2018-2024 Dolby Laboratories. All rights
reserved.

Disclaimer: Dolby has certified Iris QC Pro as a Dolby Vision metadata and packaging QC tool. Iris’
content mapping preview is not certified for Visual QC of Dolby Vision assets.

DNxHD codec used under license from Avid Technology, Inc.

Kakadu codec used under license from Kakadu Software Pty Ltd.
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1 Introduction

GrayMeta lIris is the go-to studio grade media player and quality control solution.

Iris enables media professionals to quickly and accurately collaborate and deliver ALL forms
of professional file content through the production lifecycle from asset acquisition, post-
production on through to approval and distribution.

This manual provides software installation instructions, an overview of the GrayMeta Iris and
its most common tasks. For more information, please contact FAQ and support section on the
GrayMeta website.

Visit

. Product information and software download
. Manage user account and license
. Support center for inquiries and issue management

Example Codecs

e JPEG 2000

e Uncompressed
e PRORES

e DNXHD

e XDCAM

e [IMXD10

[ ] DV

e DVCPRO

e AVC-INTRA

e MPEG2

e MPEG4/H264
e XAVC

e HEVC/H265
e Windows Media and more

Example Wrappers

o MXF
e MOV
e DPX

Version 9.5.1.194
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o IMF

o GXF
o AVI

e TIFF
e TS

o M2T
e M2TS
e MP4
e WMV
e WMA

Example Audio

e 1024 input channels, 16 output channels
e PCM

L) AAC

e AC3

e MP2

e MP3

e other compressed formats

Resolution Bits
e 8,10, 12 and 16 bits

Example Color Space

e XYZ

e SMPTE RGB 4:4:4, 8/10/12 bit
e CGIRGB range

e YCbCr4:4:4

e YCbCr4:2:2

e YCbCr4:2:0

e YCbCr4:1:1

Example Subtitle

e EIA-608 (DTVCC Transport) text stream

e EIA-708 (DTVCC Transport) text stream

e Line 21 EIA-608

o Teletext

e TX3G

e European Broadcasting Union (.STL) external files
e Timed Text Markup Language (.ITT) external files
e D-Cinema Interop (.XML) external files
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e Screen Electronics (.PAC) external files

e Distributed Exchange Format Profile (.DFXP) external files
e Subrip (.SRT) external files

e Comma Separated Values (.CSV) external files
e Scenario Closed Captions (.SCC) external files
e SAMI (.SMI) external files

e IMSC1 (.TTML) external files

e Unicode PAC (.FPC) external files

o WebVTT (\VTT) external files

e Cheetah (.CAP) external files

e Videotron Lambda (.CAP) external files

e Cavena (.890) external files

e SMPTE 428-7 external files

e Spruce STL external files

e Son external files

1.3 Supported SDI Cards

e Bluefish 444 Supernova S+, Neutron, Kronos
¢ AJA Kona 4, Kona 3G, Kona IP, Kona 5
e Black Magic Design, DeckLink Range
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2 Installation

a) Please download the installer from

b) Run the installer and follow the step by step instructions. (Select the Bluefish444 card
and/or AJA card options if the SDI card(s) are installed). The installer will prompt to
update the Bluefish drivers and firmware if they are out of date.

- N
| GrayMeta Iris v2.0.0.9 64-bit Setup = -5

Welcome to the GrayMeta Inis Setup
Wizard

This wizard will guide you through the installation of

GrayMeta Iris v2.0.0.9 64-bit.
Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update

relevant system files without having to reboot your
computer.

Click MNext to continue.

Mext > ] [ Cancel

Double-click the GrayMeta Iris shortcut on the desktop to start. Or from the startup menu to
start Iris.

Version 9.5.1.194
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3 Getting Started

€2 signin

Email:

¥ Remember me

‘Work offline (without a project) Reset Password Create Account

Don't show this dialog on Iris startup

After starting the application, a sign-in dialog box will appear. You must sign into Iris to access the
Projects, Message Board and Annotations, otherwise you can skip the sign-in dialog box by closing
it or disable it in the options (see 4.3.22.1.3)

Signing in will use one of the following types of accounts:

o Private Iris Service where the accounts are held in a user-defined server.
¢ Active Directory account, which requires extra configuration in the Iris Admin GUI (please
consult the Iris Admin manual for further information).

Iris Anywhere has support for OKTA (SSO). An OKTA account is required to use this feature. From
OKTA’s account application settings, the Client ID and OKTA domain must be specified in iris
Anywhere’s config.js file. Also, in the OKTA'’s application settings, the application grant types must
be specified as shown below:

APPLICATION
Application name My SPA

Application type Single Page App (SPA)
Allowed grant types Client acting on behalf of a user
Autherization Code

Implicit

Allow ID Token with implicit grant type

Allow Access Token with implicit grant type

The config.js file (located in C:\Users\Public\Documents\GrayMeta\lris Anywhere\config.js) will need
the OKTA settings to point to the correct Client ID and OKTA domain. For example:
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Okta: {
enabled : true,
issuer . 'https://dev-02238043.okta.com/oauth2/default’,
client_id :'0oa2z8e9zpw1azJn6534',
redirect_uri : '/implicit/callback’,
scope : 'openid profile email’
}

Means that the client ID is '00a2z8e9zpw1azJn6534’ and the domain (specified in issuer) is ‘dev-
02238043.0kta’. Replace the client ID and domain with the values obtained from your OKTA
account.

If you are using Iris within your organization, where a privately hosted Iris Service has already been
established, the IP address of that service must be created before it can be accessed. Click the
“Work Offline” link (or press the ESCAPE key) to cancel the sign-in dialog box. Using the mouse,
right-click on the main player window to bring up the context menu and then select “Options” then
“Server Settings.”

Version 9.5.1.194
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£ options

Import Settings  Export Settings

In order to specify usage of a privately hosted Iris Admin, the information pertaining to the server
needs to be entered in the Iris Admin GUI and a .dbs file generated (please consult the Iris Admin
user manual for details on generating the .dbs file). The .dbs file is imported by clicking the “Import
Settings” button as shown above. Also, ensure the “Use Imported Database Settings” option is
selected. Once the .dbs file has been imported, you can sing in to Iris again by leaving the options
and clicking “Sign In” button on the top right.

Iris supports the option of importing settings from a known drop folder. This occurs as soon as Iris
starts up and it will look in the C:\Users\Public\Documents\GrayMeta\lris\ServerSettings drop
folder for files to import. By importing these settings, they will override existing settings. There are
current two types of settings that can be imported — a server settings .dbs file as mentioned in
section 3.3 and general settings.

To import a .dbs file copy the .dbs file that was generated by Iris Admin and place it in the drop
folder C:\Users\Public\Documents\GrayMeta\lris\ServerSettings. Upon startup, Iris will import
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this file and move it into another location called
C:\Users\Public\Documents\GrayMeta\lris\ServerSettings\ImportedServerSettings.

Similarly, to import general settings, a settings.json file needs to be manually created and placed in
the drop folder C:\Users\Public\Documents\GrayMeta\lris\ServerSettings. Once this has been
imported upon Iris startup, it will also be copied into
C:\Users\Public\Documents\GrayMeta\lris\ServerSettings\ImportedServerSettings

The settings.json file currently support one setting that is represented in json format. A typical
settings.json file may look like the following:

{

"AutoLoginActiveDirectory": true

€Y Create User

First Name: John

Last Name: Smith

Company: MyCompany
Phone: +1 12345678

Country: U S

Email address: Jjohn.smith@mycompany.com

Confirm Password: 29900

I have read and agreed with the Pri

Cancel

In the sign-in dialog box, you can click “Create Account” link to register your details. Enter your
name, company and contact information. All fields are required, except the phone extension field.
Your email address will be used to uniquely identify you whenever you sign into Iris. Please read
and accept the Privacy Policy statement carefully before proceeding. Select OK to create the
account. After your account has been created successfully, the sign-in dialog box will reappear and
you can sign into Iris using your email address and password.
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Note that if you are using Active Directory sign in (which can be enabled in the Server GUI), the
“Create Account” link will not be available.

User accounts can be placed into groups. When a user account is placed in a group, the
individual’s account permissions are overridden by the group’s permissions. A group can be an Iris
Group or a group created in an Active Directory server. For Active Directory users that are
members of more than one group, signing into Iris will result in Iris presenting the user with a list of
groups, of which the user must choose one.

These groups and their permissions are managed in the Iris Admin GUI. For further details, please
consult the Iris Admin user manual.

Iris can be licensed using either a locally stored license file or via online licensing. The local license
requires importing the licensing file (see section 4.3.25) and the online licensing requires the
following:

e Importing an online license file into an Iris Admin database (please consult the Iris Admin
user manual for more information)

e Entering the Customer ID into Iris (see section 4.3.1.3 for information on entering the
Customer ID)

Both types of licenses can be unlimited or use start and end dates. If Iris is licensed using both a
local license and server license, then the local license takes precedence. Additionally, the server
license is used to manage the number of concurrent users who are using Iris at any given time.

Signing in to use projects (see section 4.3.1) or configuring Iris to use a Server License (see section
4.3.22.19.2) will take up one slot in the list of users currently using Iris. The maximum number of
slots taken up must not exceed the number of concurrent users mandated by the Server License.

You can use Iris in “Offline” mode without signing into an Iris Service by clicking the “Work Offline

(without a Project)” link or by pressing the ESCAPE key. Please contact to
purchase a license. When working offline, Projects, Message Board and Annotations will not be
available.

Version 9.5.1.194
13 ] META

© 2024 Copyright GrayMeta. All Rights Reserved.


mailto:sales@graymeta.com

Iris Play User Manual

4 Using GrayMeta Iris

3 Iris and The Hit TV Series 1080p.mp4 - GrayMeta Iris

Sign In -0OXx

IN:1920x1080p24 .00Hz PC:2560x1440p58Hz

Player Controls

«
00:00:00:00 K L ] M 00:01:14:06
00:00:13.333
00:00:13:08
00:00:13:08
321

4.1.1 Horizontal Progress and Seek Bar

Play head indicates the current position of the playback and allows the user to randomly seek to

any position of the video. Mark in and out points to the start and end positions of the playback
respectively.

Mark in point Mark out Point

<
00:00:00:00 M~

>
M 00:02:43:08

Set Mark in point Playhead Set Mark out point

4.1.1.1 IMF Files

Version 9.5.1.194
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When playing IMF files, the seek bar will also show 2 types of information represented as blue
markers and yellow markers:

<
00:00:00:00 M

The blue markers represent the beginning of a video segment and the yellow markers represents
markers to denote points of interest within the video. Each one of the blue and yellow dots are
referenced by frame positions. Hovering the mouse over the markers will show a tool tip with further
information and clicking the markers will cause the player to seek to the position of the marker.

4.1.1.2 Dolby Vision® Files

When playing Dolby Vision files, the seek bar will also show orange markers that represent Image
Characters and Trim.

3
01:00:00:00 K‘—. M 0L00:12:11

The Image Character and Trim can be viewed by hovering the mouse over the orange markers and
clicking the markers will cause the player to seek to the position of the marker.

4.1.2 Time Display

Current display mode: Tape Time Code (TCR), Control Time Code (CTC), Time position (TIME)
or absolute FRAME. Click on the “Time”, “TCR”, “CTC” or “Frame” buttons to select the active
mode.

00:00:13.333
00:00:13:08

00:00:13:08
321

Time format: hours: minutes: seconds: milliseconds

TCR / CTC format: hours: minutes: seconds: frames. A semi-colon ‘;’ separator between the
seconds and frames counter denotes drop-frame timecode.

It is possible to jump to a specific position in the video by editing the Time Display. Editing mode is
enabled by double-clicking on the time display and entering the new position to jump to followed by
ENTER key. Press ESCAPE to cancel edit mode. The current display mode (Time, TCR, CTC and
Frame) determines how inputted data is interpreted during edit mode, so if the current display mode
is in time code, then a time code must be entered during edit mode.

4.1.3 Player Control

Version 9.5.1.194
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Stop the current playback.
Rewind the playback. Supports the following speeds: 2x,
4x, 8x, 16x, 32x and 64x.

Begin playing the video. Button changes to Pause while
playing.

Pause the playback. Button changes to Play when paused.

Fast forward the playback. Supports the following speeds:
2X, 4x, 8x, 16x, 32x and 64x.

Select a file to be played.

When the video finishes, it automatically repeats it once.

Play video repeatedly. When the video finishes, it
automatically starts playing again.

Normal playback mode: Stop at end.

The Slow-motion mode to change the rewind and fast
forward speed to (1/16, 1/8, 1/4 and 1/2).

Search and jump to position.

HE oo BB B ENMEBE D

Switch to default full screen mode.

4.1.4 Search and Jump

é Time Code Search

Time Hour Minute Second Frame
® TCR 0= 0% : 0% : 0=
CTC

Frame

Select the search mode, time code track, control track, play time or absolute frame. Enter the
required position and click “Search.” The play position will jump to the specified value if found.

4.1.5 Audio Control

Version 9.5.1.194
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B  Adjust the volume level.

m Click to mute audio.

m Click to un-mute audio.
4.1.6 Panning of Video

If the video is scaled so that it is larger than the display window, then the left clicking and dragging
the display allows for the video to be panned.

4.2.1 Individual Floating Windows

E=N00:01:04.208

00:01:04.05
S 00:01:04.05
=3 1542

Iris is comprised of a main player window and a set of ‘tool’ windows that can be placed
anywhere on the screen for convenience. However, with so many tool windows available, it

Version 9.5.1.194
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is quite difficult to navigate around the windows and to set up a layout that best suits your
needs.

4.2.2 Docking a Window

«
K

K23 00:00:47.166
EEN00:00:47:04

1IN.NAN.A7.NA

To dock a window to another window, click and grab the title bar of the window you want to
dock and then move the mouse over the window you want to dock to. As the mouse moves
over the window, docking ‘handles’ appears in the middle and edges of the window. By
moving the mouse over the handles, an outline of where the window will dock will be
highlighted. Since a window may already contain multiple windows, moving the mouse over
different parts of the window will show multiple docking handles. To dock the window,
release the mouse button when the desired position is highlighted.

Version 9.5.1.194
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Player Controls

“
10:00:00:00 K

»
N 10:02:28:14

B2 00:00:40.250
= H « » &
E=N00:00:40:08 Il
] 10:00:40:08 |
| Frame f1294

Waveforms Monitor

The resultant layout shows the video waveform docked to the bottom of the player controls
which in turn is docked to the bottom of the main player. The dividing borders between the
windows can be dragged to resize the windows. To undock a window, click and grab the title
bar of the tool window and move it away from its position in any direction. Release the
mouse, and the window will reform back to a floating tool window.

Version 9.5.1.194
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4.2.3 Docking Tabs

Audio Meter

-60 -20 -10

140 ]
2 4 ]

Audio Phase Meter

When you release the mouse over the center handle, the window forms a tabbed layout. To
bring a window to the top, click on the tab name on the bottom.

4.2.4 Saving and Restoring the Window Layout
See the ‘Docking Layout’ context menu on how to save and restore a window layout.

Using the mouse, right-click on the main player window to bring up the main context menu.
This menu provides access to most of the features and functions of Iris.

Iris Account >
Project r
Open File Cirl+0

Open Test Pattem

Close File
Recent Files »
Timecode (TCR) »
Audio >
Captions/Subtitles »
Tools >
Docking Layout Ctrl+Shift+D
Display Size »
Time Display »
On-Screen Overlay »
Video Scaling »
Capture Image to Clipboard »
Video Controls >
Audio Controls >
Options

Licensing Informaticn

Import License

Help Fl
About

Exit Alt+F4

Version 9.5.1.194
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4.3.1 Iris Account

4311 Signin

€2 signin

Email:

¥ Remember me

Work offline (without a project) Reszet Password Create Account

Don't show this dialog on Iris startup

Use this menu to sign into your Iris account. Signing in will use one of the following types of
accounts:

o Private Iris Service where the accounts are held in a user-defined server.
e Active Directory account, which requires extra configuration in the Iris Admin GUI (please
consult the Iris Admin manual for further information).

If the checkbox “Don’t show this dialog on Iris startup” is enabled, then future sessions of Iris
will open without the sign in dialog and will run in Offline Mode. This setting can be changed
again in the “General” tab of the Options dialog (see 4.3.22.1.3). Also, the sign in can be
selected manually from the context menu.

4.3.1.2 Sign Out
Sign out from an active session.

4.3.1.3 Change Details
Change your personal information, password or license.

Version 9.5.1.194
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€Y Change Details

First Name: John

Last Name: Smith

Company: MyCompany
Phone: + 1 1234567

Country: ug

Current valid period: ! 018 12:51:00 PM to 12/31/9999 11:59:00 PI
Controlled by hardware license

Update License

Customer ID:

Change Password
Current Pass
MNew

Confirm Mew Pas

This dialog box also displays the validity of your license and the “Customer ID” which is used
for enterprise licensing (for your organization). The Customer ID will be provided upon
purchase of a valid license.

4.3.2 Project

4.3.2.1 Open Link
A direct link to a project and annotation position can be shared, and the link can be entered
here to open the project.
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= Open Link

Paste your link here: |;

Cancel

4.3.2.2 Save Project As...
Save the current project with a new name.

& Save As Project

Project Name: |[ris and the Cliens Reviews - No Wormrie

Cancel

4.3.2.3 Export Project to XML
Projects can be exported to an XML file via the “Export Project to XML” context menu. A
list of projects that are accessible to the current user is displayed as follows:

o Export Project

Select Projects | Export Options

9102015

Selected projects can be exported by clicking the “Export” button followed by a dialog that
allows the user to specify the XML file and location in which to store the exported projects.
The “Export Options” tab gives the user some options to control what can be exported,
such as specify a date range, specify not to export messages or omit thumbnails (which
results in much faster exporting).
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& Export Project

Select Projects | Export Options

Only include messages within the following
date range:

Start Date:
End Date:

The resultant export file location will include a file called report.xsl and four folders named
CSS, jQuery, moment and Thumbnails. The purpose of these additional folders and files
is to enable the exported XML file to be opened in a web browser and viewed as a report.
Here is an example of such a report shown in Internet Explorer:

e‘ ) L caTempureportiAllami £ - & [ @ rris Project Report ‘ ‘

File Edit View Favorites Tools Help

e: NetflixComplexIMF Test - No Subtitles

Message Board

I found the NetflixComplexIMFTest package. Help me find the FTP links to the other two packages? I have similar packages here but they're much larger than filesizes reported in
this project

Hi Josef, in your FTP location look for folder Sony_Plugfest Oct2015_bad_audio, Netflix-Sony_Plugfest Oct2015 and NetflixComplexIMEF Test

lDOn't forget to delete them when you have finished downloading them to your computer.

Package: Sony_Plugfest Oct2015_bad_audio - Contains subtitles S 4
d)
(RS

#105%

Note that in Internet Explorer, opening the exported XML file may result in a message
“Internet Explorer restricted this webpage from running scripts or ActiveX controls.” If this
appears, you must allow this when prompted to view the report in the correct format.

In Google Chrome, XML documents are blocked by default and the only way to open XML
documents in Google Chrome is to run it from the command line with the parameter —
allow-file-access or —allow-file-access-from-files.
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When passing exported XML files to another user, the following needs to be heeded:

o If the user requires opening the XML file as a report in a web browser, then the report.xsl file
and the four folders mentioned earlier must be included.

e If the user only wants to re-import the XML file into Iris, then it is sufficient to provide them
with the exported XML file only.

Exporting a lot of data can be time consuming and furthermore, reading very large XML
files in a web browser can also give the appearance that the web browser has hung while it
processes the large amounts of data.

4.3.2.4 Import Project from XML
This context menu option allows a user to import projects from an XML file. When selected,
the following dialog is shown:

& Import Project

XML file to import:  CATemp\report\Allxml

v
¥
v
v
¥
v
¥
¥
v

Select the location of the XML file and a list of projects in the XML file (and are authorized
for access by the current user) is shown. Choose the projects to import and click the
“Import” button. The naming of imported projects takes the form of the original project
name suffixed by “(imported on <datetime>)” where <datetime> is a date and timestamp of
the import.

Note that importing a large XML file can be very time-consuming.

4.3.2.5 Import Segment Data from XML
This allows the import of XML files containing Segment Data annotations to be imported
into the current project. An sample Segment Data XML file can be found in the Documents
folder of the Iris installed location.

4.3.2.6 Close
Close the current Project but does not sign out.
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4.3.2.7 Generate QC Report

This option allows for generation of a QC Report. The report consists of asset metadata,
loudness measurements, annotations within the project (including those that were created
by QC files such as Baton and Aurora). The report will be saved as an XML file.

For more customized reports such as generation of user-defined XML formats and even
generation of PDF formats, it is necessary to import a QC Report Config file in the Iris Admin
(for more details, see the Iris Admin user manual). The QC Report File will be a zip file that
contains xslt and json files used for customizing the reports. A sample GrayMeta QC Report
zip file is included with the Iris Admin Install (called QCReportConfig.zip). Inside will be json
and xslt files which can be customized. The customized files can be zipped up and imported
into Iris Admin. After the import, the Generate QC Report context menu will contain new
entries to allow generation of these customized reports.

4.3.2.8 QC Result

QC Results can be marked as Pass or Fail. This option provides the user the ability to mark
the results as pass or fail, and to add comments.

£ QC Result

Status:

Comments :
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4.3.3 Open File

4 Libraries
3 Documents
rJT Music
l=| Pictures

H videos

8 Computer
& wing ()
a System Reserved (D:)

11 items

File pame:

m

[ BY_SWEEP_486i59, mxf
[} €875_486i59.mxf

|| CB100_486i59.mxf

|| GREVSCALE 486i59.mxf
[ PB100_486i59,mxf

[ Uv_MB_Fs4_486i59.mxf
[ Uv_SWEEP_486i59.mxf
[} VALID_RAMP_486i59.mxf
[ ¥_MB_Fs2_486i59.mf

6/26/2013 8:05 PM MXF File

6/26/20138:06 PM  MXF File
MF File
6/26/20138:07 PM  MXF File

6/26/2013 8:07 PM MXF File
6/26/2013 8:07 PM MXF File
6/26/2013 8:08 PM MXF File
6/26/2013 8:08 PM MXF File
6,/26/2013 8:00 PM MXF File

< [

~ | [Supported Media files or Playlis |

[ open | [ conee |

& Open @
—~———
A, | . % WINT (C:) » Program Files » Archimedia Technology » Archimedialris » Patterns » 486i59.94 - |<‘?H S ,O‘
Organize * New folder =+ 0 @
-
CloudStation “ Name Date modified Type Siz *

This option allows the user to select a file for playback. For non-IMF and non-DCP packages,
the user can select separate audio files by enabling the option and clicking the Add button to
select the audio files. There is also an option to include external captions/subititles file to

27

display.

£ open
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To open an IMF or DCP package, browse the package folder and select either the
ASSETMAP.XML or a CPL.XML file. The playlists are represented as files with the name

suffixed by "_cpl" and the extension being ".xml." Please refer to Appendix F for more
information.

This option can also be used for opening Dolby Vision metadata XML files but only after a
video file has been loaded. The Dolby Vision metadata will be used for playback of the
currently opened file. This is useful when the currently opened file is intended for Dolby
Vision playback but does not contain embedded Dolby Vision metadata.

If the option to validate Dolby Vision metadata is enabled (Options->Dolby->Dolby Vision
Mastering->Validate Dolby Vision Metadata), then upon opening the Dolby Vision metadata
XML file (or opening video file with embedded Dolby Vision metadata), it will be validated
using the Dolby Vision validation tool and its results will be displayed in a window as shown
below. To continue, close the window.

2 Dolby Vision Metadata Validation
Dolby Vision metadata validation results :
File - G:\Videos\Dolby\Art_Glass_bt2020_3840x2 160 mxf

Metadata version: 2.0.5
Algorithm Version 0,0

Image aspect ratio 1.77778

Canvas aspect ratio 1.77778

Frame rate: 24.000 fps

Color Encoding: "u12 444 pq(0,10000) rgb signal bt2020"
Color encoding validation test: PASS

Level6 (MaxFALL - MaxCLL): 214.335 - 10000

Mastering displ olby Pulsar 4000-nit,P3/D65,ST 2084, Full (ID:7) - Bit Depth 16 bit - Diagonal 42in - Color Info: pq(0.005,4000)
rgb computer p3d65

Mastering Monitor validation test:

Target Displays validation test

Overlapping shots validation test:

Gap between shois validation test:

Negative shots duration validation test

Per-frame Data out of range validation test:

Number of shots: 10

Frame range 0-299

L2 Trim Count (TargetlD, Count): (1, 1) (27, 1)

L1 metadata validation test:

L2 metadata validation test:

WARNING: Target Display ID: 27 info has been modified from "pq(0,600)" to "pgq(0.005,600)"

No errors were found in the metadata
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4.3.4 Open Test Pattern

& open =
—
&) @ CPC: Program Files\Archimedia TechnologyArchimedia lris\Pattems\1080p ~ |+ || search 1080525 2|
Organize » MNew folder Bz~ [ '@'
- F *  Name ° Date modified g
- Favorites
A || BY_SWEEP_1080p25.mxf 6/13/201312:25 P!
4 Libraries 1 || CB75_1080p25.maf 6/13/201312:25 PI|E
|| CB100_1080p25.rmxf 6/13/201312:25 P!
1% Computer |_| PB100_1080p25.mxf 6/13/201312:24 P1—=
&, wing (c) || UV_ME _Fs4_1080p25.rmxf 6/13/201312:24 Pt
=a System Reserved (D:) || UV_SWEEP_1080p25. rrudf 6/13/201312:23 Pt
—w BackUp (E5) || VALIDRAMPS_1080p25. rmuf 6/13/201312:23 PI| »
= Work (F) ad O il C
11 items
|
File name: - [Test Pattern files (*.mxf;".emaf) v]
[ Open ] [ Cancel ]

A set of test patterns is installed by default to help to test systems and monitors. Additional
advanced and more complex charts can also be purchased separately from GrayMeta.
Select a test chart for playback. With our partner VideoQ, we have developed a set of
unique test patterns and charts to provide lossless quality digital signals for engineering and
test purposes such as display setup and encoder/decoding paths.

4.3.5 Open Image Sequence Folder

Browse For Folder @

Flease choose image sequence files directory

* 1 buildffrpeg a
8. Config.Msi
» 3. Documents and Settings
4 [ DPX
. 1920:1080
J Imagex - Copy

|..m

. inetpub

J Intel

J Microsoft Visual Sourcebafe
J min

; MinGW

[ Make New Folder ] [ oK ][ Cancel ]

Select the top-level folder for a set of Image Sequence folders or a single folder. The options
box will search through the folders looking for DPX, TIFF, EXR, BMP, JPG/JPEG and
TARGA files.
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4.3.6

2 Open

+ Select Directory Files in Dir Valid/Expected Sequence Start Filename
v E\New folder\1920x1080 119 119/119 # ext intersection_stockSTOCK.112

¥ Enable embedded and external subtitles
Enable deep scan (slow)

The dialog box performs several checks on the files.

1. Checks the sequence of file names is sequential, without any missing files.

2. Checks the number of files in the folder matches the sequential number of files in the
folder.

3. Displays the first and last file names in the sequence for user to verify.

The starting filename in each folder can be edited by clicking the “pen” button.
The order of the folders for playback can be changed by moving the row up or down.
Multiple audio and caption/subtitle files can be added for playback.

Close File
When a file or package of files is opened, and loaded for playback, it is locked to prevent
modification. Closing the file or package releases all files and unloads content from memory.
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4.3.7 Recent Files

Inis Account 3
Project ’

Open File Ctr«O

Open Test Pattern

Open Image Sequence Folder ..,
Recent Files ’ CA\Program Files\Archimedia Technology\Archimedia Iris\Patterns\1080p25\UVMB_Fs4_1080p25.mxf

S\ReleaseFor_Archimedia\Archimedia Reference Charts\dK\V1.0.0.1\A2_3840x2160x108itYUV_16CHN_TONES.emxf

Timecode (TCR) 4
Calristriaris and The Client Reviews -~ No Worries 1080p.mp4
Tools ’ CAlristrialNiris and The Client Reviews -- No Worries 720p.mpd
CinstnalNrnis and The Client Reviews -- No Worrnies 360p.mpd
Display Size »
TAArchimedia Samples\ABC with subtities\depb1083pafsd-16a_eng-926674.720P-HDCL16xS_5.1ENG.mpg
Time Display ’
Ciris and The Executive Producer 360p.mpd
On-Screen Overlay ’
CA\Program Files\Archimedia Technology\Archimedia Ins\Patterns\1080p25\VQMA1080p25.mxf
Video Scaling »
UACommon\CBSMDC\MOM _103014_SD.mpg
Video Controls ’ U\Common\CBSMDC\MOM_103014_HD.mpg
Audio Controls 3
Options
File Properties

License Information

Import license

Help Fl

About

Ten most recent files will be displayed in the recent list.

4.3.8 Timecode (TCR)

Timecode (TCR) » | v Track 1 MXF SourcePackage (Embedded) [00:58:25;00]
Audio 4 Track 2 MXF MaterialPackage (Striped) [00:58:25;00]
Captions/Subtitles 4 Essence Timecode Track (Striped) [00:58:25;00]

This selects the active Timecode track (TCR) if more than one track is available. An
embedded track indicates that the timecode is assigned on a frame-by—frame basis and can
be discontinuous. A striped track only contains a starting value, and all subsequent values
are regenerated, providing continuous timecode.

4.3.9 Audio

Audio » | ¥ Track 1 Test3.MXF (1-Chn 24-bits 48000Hz PCM signed 24-bit little-endian)
Captions/Subtitles » | v Track 2 Test3.MXF (1-Chn 24-bits 48000Hz PCM signed 24-bit little-endian)
v Track 3 Test3.MXF (1-Chn 24-bits 48000Hz PCM signed 24-bit little-endian)
Display Size »
v Track 4 Test3.MXF (1-Chn 24-bits 48000Hz PCM signed 24-bit little-endian)
Time Display »
On-Screen Qverlay » | v Enable Multiple Track Selection

This selects the input audio tracks to be processed. Each track may have one or more
channels and all selected tracks are combined to form the output channels. The order of the
tracks cannot be changed by this selection. Use the audio router to rearrange the order or to
mute individual channels. Unchecking the “Enable Multiple Track Selection” menu will allow
only one track to be selected at a time.
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4.3.10 Captions / Subtitles

Captions/Subtitles 3 Load Captions/Subtitles Files
Tools v |« Live Tracks 3
Docking Layout Ctrl+5hift+D Preprocessed/External 3

When a file is loaded for playback, the “Open File” dialog has the options to choose whether
to extract ‘live’ captions in real time from the video source file as well as to ‘pre-process’ the
files prior to playback so that the dialogue appears in the Caption Viewer.

The Live Tracks will appear under the Live Tracks menu option:

Captions/Subtitles 3 Load Captions/Subtitles Files
Tools b |  Live Tracks 2 Display Type
Docking Layout Ctrl+5hift+D Preprocessed/External » | « EIA-608/708 SMPTE 334-2 CDP

While a live track is selected, the display type can be chosen:

Captions/Subtitles 3 Load Captions/Subtitles Files

Tools » | « Live Tracks 3 Display Type b | ¥ B08
708

Docking Layout Ctrl+Shift+D Preprocessed/External » | + EIA-608/708 SMPTE 334-2 CDP

XDS

Only display types applicable to the live tracks are available for selection. For example, if an
SCTEZ20 live track is selected, the 708 display type will be disabled as this does not apply to
SCTEZ20 tracks. Typical display types are EIA-608 SCTE20 (containing SCTE 20
captions/subtitles), EIA-608 SCTE128 (containing 608, 708 and XDS captions/subtitles) and
Line 21 EIA-608 (containing line 21 captions/subtitles).

Preprocessed and external subtitle files will be listed under the Preprocessed/External menu

option:
Captions/Subtitles 3 Load Captions/Subtitles Filec
Tools v || ¥ Live Tracks 3
Docking Layout Ctrl+Shitt+D Preprocessed/External 3 ELA-BUE SCUTELZE CL1 (Language : Unknown) |StoryCorpsNature_ot_War_Q 1UC.mov]
—_ EIA-608 SCTE128 CC2 (Language : Unknown) [StoryCorpsNature_of_War_QTCC.mav]
icplay Size .
R EIA-708 SCTE128 Service 1 (Language : eng) [StoryCorpsNature_of_War_QTCC.mov]
ime Displa; 3
P EIA-708 SCTE128 Service 2 (Language : eng) [StoryCorpsNature_of_War_QTCC.mov]
On-5Screen QOverlay 3
SubRip (Language : Unknown) []
Video Scaling > . . . .

‘Live’ caption tracks are also passed to the SDI as embedded SMPTE 334-2 708 CDP in its
native format which may include 608, 708 and XDS data.

4.3.10.1 Teletext
Since teletext are accessed by specifying page numbers, it is necessary to select the
required page number when switching to teletext captions/subtitles. The teletext context
menu allows for selection of pages 801, 802, 888 (this is the default) and 889.
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am
an2
v 888
8a9

Custom

For other pages, the custom option is required to add or remove teletext pages to the
context menu.

£ customise Teletext Page Numbers

Teletext Page Number:

Cancel

To add a page number, enter the page number and click Add button. To remove page
numbers, select the required page numbers (use SHIFT and/or CTRL to select multiple
page numbers) and either click the remove button or right click the selected page numbers
and select Remove from the pop up context menu.

4.3.10.2 Load Caption/ Subtitle File

The user can manually add further files for processing at any time using the Load
Caption/Subtitle menu.

4.3.10.3 Subtitle type

This selects the active track for display. Only pre-processed captions are available in the
Captions/Subtitles Viewer.
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ptions/Subtitles Viewer 1 - Track EIA-608 5CTE128 - CC1 (Language: Unknown) -

00:00:14:06
00:00:17:06
00:00:17:06

00:00:26:19
00:00:31:03
00:00:31:03
00:00:34:00
00:00:35:14
00:00:38:09
00:00:38:09
00:00:40:00
00:00:40:00
00:00:42:25

00:00:17:04
00:00:19:17
00:00:19:17
00:00:20:23
00:00:22:19
00:00:22:19
00:00:24:03
00:00:26:17
00:00:26:17
00:00:31:01
00:00:31:01
00:00:34:00
00:00:34:00
00:00:35:12
00:00:38:08
00:00:40-00
00:00:40:00
00:00:42:23
00:00:42:23
00:00:46:08

[rap music]
MAX, THAT CAR
HAS BEEN PARKED QUTSIDE
FOR A WEEK NOW.
DO YOU THINK
THEY'RE SELLING DRUGS?
LET ME REPHRASE THAT.
ARE THEY SELLING DRUGS
TO YOU?
NO. THEY'RE NOT
BUYING EITHER.
HI. WE HAVE A NEW
MOCHACCING CUPCAKE.
OH, NO. NO, NO, NO.
THAT CAR'S NOT WITH US.
WELL, THAT'S
THE THIRD CUSTOMER
THAT DIDN'T STOP

BECAUSE OF THAT RAP CAR.

TO BE FAIR, THIS PLACE

Pop On 8.00, 14.00
Pop On 0.00, 13.00
Pop On 0.00, 14.00
Pop On 0.00, 14.00
Pop On 0.00, 13.00
@] v Autoscroll

Foj Fontsize
Poj
Poyj

v Set Active

Poj Save to CSV file

Poj

Poj

Pop On 4.00, 14.00
Pop On 0.00, 14.00
Pop On 0.00, 14.00
Pop On 0.00, 13.00
Pop On 0.00, 14.00
Pop On 0.00, 13.00
Pop On 0.00, 14.00
Pop On 8.00, 13.00

The Captions/Subtitles Viewer consists of the following columns:

e Time In and Time Out — Specifies a time window (in hours, minutes, seconds,
milliseconds) in which the subtitle text is displayed.
o Display — Specifies how the subtitle text is to be displayed — can be pop on, paint on,
roll up.
¢ Origin — Specifies the origin of the subtitle text. In the case of EIA-608 and SCC
subtitles, this refers to the row number and column number. In other cases, this
represents the origin as either percentage, pixels or points and will be indicated as
such — eg. (10%, 20%) or (10px, 20px) or (10pt, 20pt).
o Extent — Specifies the width and height of the bounding rectangle in which the
subtitle text is placed within. As with the Origin column, this can be represented as
rows and columns, percentage, pixels or points.
e H-Align — Indicates how the text is aligned horizontally. This can be left aligned,
center aligned or right aligned.
¢ V-Align — Indicates how the text is aligned vertically. This can be top, center or
bottom.
e Subtitle Text — This is the text that will be displayed.
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The Captions/Subtitles Viewer provides a preview of the currently selected captions/subtitles
track. As well as providing a preview, it also offers the ability to position the player at the
point where subtitle text begins or ends.

Double-clicking on a time in the Time In column will position the player at the first frame in
which the text appears. Double-clicking on a time in the Time Out column will position the
player at the last frame in which the text is shown.

The row highlighted in blue indicates that the text is currently being shown in the player.
Note that more than one row may be highlighted if the player’s current play time are within
the time in and time out values.

The row indicated in blue may scroll off the top or bottom of the Captions/Subtitles Viewer,
hence an option is provided as a context menu (shown in screenshot above) to enable or
disable ‘Autoscroll.” The other options in the context menu allows for toggling of an option for
the Captions/Subtitles Viewer to be always on top and for choosing a font size to be used to
preview the captions/subtitles.

See Appendix G for more information on Captions and Subtitle formats and editing of STL

files.

4.3.10.4 Searching for Text in Captions/Subtitles Viewer
The captions/subtitles viewer contains a search bar allowing for specified text to be

searched.

Captions/Subtitles Viewer 1 - Track EIA-608 SCT

00:00:14:06
00:00:17:06
00:00:17:06
00:00:19:19
00:00:20:25

00:00:24:04
00:00:24:04
00:00:26:19
00:00:26:19
00:00:31:03
00:00:31:03
00:00:34:00
00:00:35:14
00:00:38:09
00:00:35:09
00:00:40:00
00:00:40:00
00:00:42:25
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00:00:17:04
00:00:19:17
00:00:19:17

00:00:31:01
00:00:31:01
00:00:34:00
00:00:34:00
00:00:35:12
00:00:38:08
00:00:40:00
00:00:40:00

R42:23

00:00:46:08

[rap music]
MAX, THAT CAR
HAS BEEN PARKED OUTSIDE
FOR A WEEK NOW.
DO YOU THINK
THEY'RE SELLING DRUGS?
LET ME REPHRASE THAT.
ARE THEY SELLING DRUGS
TO YOU?
NO. THEY'RE NOT

BUYING EITHER.

HI. WE HAVE A NEW

MOCHACCINOG CUPCAKE.
OH, NO. NO, NO, NO.
THAT CAR'S NOT WITH US.
WELL, THAT'S
THE THIRD CUSTOMER
THAT DIDN'T STOP
BECAUSE OF THAT RAP CAR.

TO BE FAIR, THIS PLACE
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C1 (Language: Unknown) -

Pop On (8.00,
Pop On |0.00,
Pop On |0.00,
Pop On |0.00,
Pop On |0.00,
Pop On |0.00,
Pop On |0.00,
Pop On |0.00,
Pop On |0.00,
Pop On (8.00,
Pop On (8.00,
Pop On 4.00,
Pop On 4.00,
Pop On |0.00,
Pop On |0.00,
Pop On |0.00,
Pop On |0.00,
Pop On |0.00,
Pop On |0.00,
Pop On (8.00,
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To carry out a search, enter the search text in the search bar and hit Enter. Matched text will
be highlighted. It is possible to cycle through each of the matches by clicking the “<” and “>”
buttons to go to the previous and next match, respectively. Cycling through the matches will
highlight the current matched text in red.

4.3.10.5 Offset

Each captions/subtitles viewer window can be configured with its own individual timing. Note
that where a global offset is specified (see Error! Reference source not found.), then the g
lobal offset will be added to the captions/subtitle viewer’s offset, therefore if an offset of 1
second is specified here and the global offset is 3 seconds, the net effect is an offset of 4
seconds.

To apply an offset to the captions/subtitles viewer, click the settings icon as shown below:

‘Subtitles Viewer 1 - Track EIA-608 SCTE128 - CC1 (Language: Unknown) -

® Use Time Offset : 0% ms

00:00:14:06 | 00:00:17:04 | [rap music] Use Timecode Offset :
00:00:17:06 | 00:00:19:17 | MAX, THAT CAR Hour

00:00:19:17 | HAS BEEN PARKED OUTSIDE

00:00:20:23 | FOR A WEEK NOW.

00:00:22:19 | DO YOU THINK

00:00:22:19 | THEY'RE SELLING DRUGS? L ——

00:00:24:03 | LET ME REPHRASE THAT. Pop On |0.00, 14.00

00:00:26:17 | ARE THEY SELLING DRUGS Pop On |0.00, 13.00

00:00:26:17 | TO YOU? Pop On |0.00, 14.00

Min Sec  Frame

o=l O L1 (P =

[¥e]

00:00:31:01 | NO. THEY'RE NOT Pop On |8.00, 13.00

00:00:26:19 | 00:00:31:01 | BUYING EITHER. Pop On |8.00, 14.00
00:00:31:03 | 00:00:34:00 | HI. WE HAVE A NEW Pop On |4.00. 13.00
00:00:31:03 | 00:00:34:00 | MOCHACCINO CUPCAKE. Pop On |4.00. 14.00
00:00:34:00 | 00:00:35:12 | OH, NO. NO, NO, NO. Pop On |0.00, 14.00
00:00:35:14 | 00:00:38:08 | THAT CAR'S NOT WITH US. Pop On |0.00, 14.00
00:00:38:09 | 00:00:40:00 | WELL, THAT'S Pop On |0.00. 13.00
00:00:38:09 | 00:00:40:00 | THE THIRD CUSTOMER Pop On |0.00, 14.00
00:00:40:00 | 00:00:42:23 | THAT DIDN'T STOP Pop On |0.00, 13.00
00:00:40:00 | 00:00:42:23 | BECAUSE OF THAT RAP CAR. Pop On |0.00. 14.00
00:00:42:25 | 00:00:46:08 | TO BE FAIR, THIS PLACE Pop On |8.00, 13.00

Select whether to use a time offset or a timecode offset, enter the amount to offset and click
Apply.
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4.3.11 Display Size

| Display Size » Auto Size  F7
Time Display ' Aspect Ratio 3
On-5creen Overlay 3
Video Scaling 3 Zoom '
Viden Cnntrale L AL '

This sets the display size of the PC on-screen video. This has no effect on the SDI output.

4.3.11.1 Auto Size
Video is displayed in the aspect ratio based on the file header information and the
calculated picture size to fit the player window size.

4.3.11.2 Aspect Ratio

4.3.11.2.1File Aspect
Video is displayed in the aspect ratio specified in the file only.

4.3.11.2.21:1 Pixel Size
Video is displayed in actual size (1:1) pixel on-screen.

4.3.11.2.34:3
Video is displayed in 4:3 aspect ratio.

4.3.11.2.416:9
Video is displayed in 16:9 aspect ratio.

4.3.11.2.514:9
Video is displayed in 14:9 aspect ratio.

4.3.11.2.621:9
Video is displayed in 21:9 aspect ratio.

4.3.11.3 Zoom

4.3.11.3.1 Zoom — Fit to Window
Video is stretched to fit the current window size maintaining aspect ratio.

4.3.11.3.2Zoom 25% to 400%
Display video at 25% to 400% of actual pixel size.
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4.3.11.4 Full Screen

Display Size » | ¥  Auto Size F7
Time Display »
Aspect Ratio 3

On-Screen Overlay 3
Video Scaling 4 Zoom 4
Video Controls » Full Screen > Window Mode F11
Audio Controls »

Default Monitor F9
Options

Monitor 1 Ctrl+Shift+1
Licensing Information Monitor 2 Ctrl+Shift+2

Video on the PC screen can be displayed in full screen mode.

4.3.11.4.1 Window Mode
The video can be made to fill the entire screen that the application is currently visible on but
it uses the current desktop resolution and frequency. The transport control panel can be
made visible by moving the mouse near the bottom of the screen. To quit full-screen, press
the ESCAPE key. This mode is commonly known as ‘Software mode’ because the display
resolution and frequency does not change and switches very quickly. The default shortcut
key is F11.

4.3.11.4.2Hardware Mode
For ‘Hardware mode’, the full screen is achieved by switching the horizontal and vertical
timing signals of the display to match the resolution and frequency of the video content. This
produces the smoothest video because the display is locked to the video timing. The default
shortcut key for ‘Hardware mode’ full screen is F9. To quit full-screen, press the ESCAPE
key. If there are multiple monitors in the system, the menu will display the available monitors
that full screen can be performed on. In this mode, the transport control panel is NOT visible
and transport controls can only be actioned via shortcut keys.

4.3.12 Time Display Window

| Time Display » | Show Track Time Code
On-5creen Overlay » Show Control Tirme Code
Video Scaling k Show Frame Count
Video Controls » Show Play Time

Switch between Time Code, Control Time code, Frame count and Play time.

4.3.12.1 Show Time Code
Set Time Display Window to show Time Code.

TCR format: hours: minutes: seconds: frames
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4.3.12.2 Show Control Time Code
Set Time Display Window to show Control Time Code. This is a presentable time code
sequence that is available on all files.

CTC format: hours: minutes: seconds: frames

4.3.12.3 Show Frame Count
Set Time Display Window to show Frame Count.

Frame Count format: frame count starting from 1

4.3.12.4 Show Play Time
Set Time Display Window to show Play Time.

Play Time format: hours: minutes: seconds: milliseconds

4.3.13 On-Screen Overlay (OSD)

On-Screen Overlay b | v Enable Overlay Ctrl+Y
Video Scaling 3 Enable SDT Overlay
Capture Image to Clipbeard * | v Time Display
v Audio Levels
Video Controls 3
v Video Properties
Audio Controls 3
v Closed Captions
Options Closed Captions Grid
Area Markers
Licensing Information
Custom Image
Import License
Custom Text
Help Fl
HDR Line Range
About
HDR Histogram

This sets the information to be displayed on the PC on-screen overlay. It does not output to
SDI.

4.3.13.1 Enable Overlay
Enable On-Screen overlay (OSD) with Time Display, Audio Level and/or Video information.

4.3.13.2 Enable SDI Overlay
Enable Overlay on SDI output.

4.3.13.3 Time Display
Time Display is set to be displayed as overlay (OSD).

4.3.13.4 Audio Levels
Audio Levels is set to be displayed as overlay (OSD).

4.3.13.5 Video Properties
Video Properties is set to be displayed as overlay (OSD).
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4.3.13.6 Closed Captions
Show captions or subtitles if available on the PC display (OSD).

4.3.13.7 Closed Captions Grid
DE OB ¥ Wil de 4 = SN Signin

Line Range All

Because the earth needs |a good
lawyer .

« >
00:00:00:00 N comm— M 00:27:13:23

00:04:14.454

b B« » a

00:27:13:24
00:04:14:06 - . .
W 00:04:14:06 . . . H EEEE

7627

) =——g

This shows the CEA608 grid of 15x32 or CEA708 grid of 15x42 depending on the caption
format selected. This allows verification of text positions within the grid.
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4.3.13.8 Area Markers
Om OB ¥l Wi dr 4 EHEHEEER Sgnin o x

Line Range All v e~ - ¢~

Because the earth needs a good
lawyer

(> Player Controls

< 3
00:00:00:00 H co——— M 00:27:13:23

EZ3N 00:04:14.454 T P «» a

=¥ 00:04:14:06 - . .
Il 00:04:14:06 . o o MF < B Q [l

7627 ¢) =——o

Shows the 4:3 aspect ratio markers in 16:9 content and a safe area marker around the
picture. The size of the safe area marker is adjustable in the Options dialog box.

4.3.13.9 Custom Image
Toggles the display of a custom image (specified in the Overlays section of the Options
page) to be overlaid on the video.

4.3.13.10 Custom Text
Toggles the display of custom text (specified in the Overlays section of the Options page)
to be overlaid on the video.

4.3.13.11 HDR Line Range

On-Screen Qverlay b | v Enable Overlay Ctrl+Y
Video Scaling 3
Capture Image to Clipboard LR
v
Video Controls 3
v
Audio Controls 3
v
Options

Licensing Information
Import License

Help F1
About

v HDR Line Range
HDR Histogram
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This option only applies if the content is HDR. The HDR Line Range represents the lowest
and highest brightness level for each line in the picture. The lowest level are in the left, the
highest levels are on the right. For any values that falls below a minimum brightness or
exceeds the maximum brightness, that part of the line will be shown in a different color (the
default being red). These limits are taken automatically from the Mastering Display
Luminance minimum and maximum metadata values if present.

€ Exodus_UHD_HDR_Dynamic_Mode Draftmp4 - Iris QC Pro D& OB ¥ ln Wil Qe

195 326 509

PQiits 0 3 10 400 1000 10000

When the content has high random highlights, the traces may appear scattered and
difficult to see. Turning the “Filter Line Range” on in the HDR options page will perform a
low pass filter on the data to provide a smoother and more visible trace.

The HDR Line Range can be toggled on and off with this option. Note that selecting this
option will turn off HDR Histogram (the two options are mutually exclusive). Also, turning
on HDR Line Range will turn off all non HDR related other overlays. Turning HDR Line
Range off will re-enable the non-HDR overlays that were previously turned off.

See 4.3.22.9.3 HDR Overlay for details on changing the colors of the HDR Line Range.

4.3.13.12 HDR Histogram
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On-Screen Overlay » | v Enable Overlay Ctrl+Y
Video Scaling 3
Capture Image to Clipboard |V
. v
Video Controls r
v
Audio Controls 3
v
Options

Licensing Information
Import License
Help F1

HDR Line Range
About

v HDR Histogram

This option only applies if the content is HDR. The HDR Histogram shows the distribution
of levels of the video content across the entire frame. For brightness levels that falls below
a minimum threshold or exceeds a maximum threshold, that part of the histogram is shown
in a different color (the default being red). These limits are taken automatically from the
Mastering Display Luminance minimum and maximum metadata values if present.

€ Exodus_UHD_HDR_Dynamic_Mode_Draftmp4 - Iris QC Pro D& O A ¥ la Wil e

4 195 326 509

0.001%

120dB

400 1000 4000 10000

00:00:02.875
=N 00:00:02:21
00:00:02:21
EZ3 70

The graticules along the top X-axis indicate the absolute digital level from 0 to the
maximum range. The bottom X-axis indicate the same level in nits for PQ or percentage of
light level for HLG. The left Y-axis indicate the percentage of values within the frame and
the right Y-axis indicate that percentage in decibels (100% = 0 dB).

This option toggles the HDR Histogram on and off. Note that selecting this option will turn
off HDR Line Range (the two options are mutually exclusive). Also, turning on HDR
Histogram will turn off all non HDR related other overlays. Turning HDR Histogram off will
re-enable the non-HDR overlays that were previously turned off.
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See 4.3.22.9.3 HDR Overlay for details on changing the colors of the HDR Histogram.

4.3.14 Video Scaling

Video Scaling ¥ ” MNone

Video Controls ¥ NTSC Letterbox 16:9
Audic Controls r MNTSC Anamorphic 16:9
Tool Windows 4 Custom ...

The video scaling applies to both the PC display and the SDI. The scaling mode can be set
in the Options > Playback setting.

4.3.14.1 None
No Scaling.

4.3.14.2 Suggested Scaling
Suggested Scaling based on known sizes of certain formats.

4.3.14.3 Custom
Custom video Scaling

o Custom Video Scaling

Current Video Size: 1280 x 720 (16:9)

Scaling Width : : Keep aspect ratio

Scaling Height : 2 Keep aspect ratio

OK Cancel

4.3.15 Tool Windows

Tools 3 Projects

Video >
Docking Layout

Audio 4
Display Size 3 Annotations 3
Time Display 3 File Properties

-

On-Screen Overlay v Asset Metadata

Video Scaling

-

v Playlist Ctrl+F1

v Status Panel

Viden Contrnls 3

4.3.15.1 Projects
The Projects window is the central place for organizing folders, projects and media files.
Projects are located on the left Project Window and are organized in a file explorer style tree
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as shown below. Right clicking on the background of the Project Window brings up a context
menu that allow further options.

il Projects
* My Projects i rs Groups Settings Preset Annotations
~ & New Folder
~ & New Folder
= ~
v @ New Folder

& Project 5 New Folder |
& Project 2 New Project
& Project 3
o 2 Reload this Project Tree
roject 4 i

rTest ¥
SHAWLL... =
& test updated project 123 abcdef 114 £

4

Select menu “New Folder” to create a folder. At each tree folder location (including the root
location “My Projects”), you can select menu “New Project” to create a new project at that
location. Although the Project Tree will auto update as other users invite you to their projects,
a manual update can be triggered by selecting “Reload this Project Tree” to reload and
update the project tree with the latest projects.

4.3.15.1.1 Adding Media

Add Package

Refresh All Thumbnails

Reload this Project

For each project, multiple media files can be added either by dragging files from Windows
Explorer to the right-hand media window or by the context menu > Add Package. For Image
Sequences, the folder containing the image sequences can be dragged and dropped into
the right-hand media window. For DCP and IMF packages, the assetmap.XML file can be
dragged and dropped in.
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_3 Open

F\Iris and The Hit TV Series 1080p.mp4

e file
30p.mp4)

« Use 'live’ captions / deo source file

Cancel

The “Open” file dialog box allows the user to add additional audio and caption or subtitle
files to the package.

Select the “Use audio from video source file” checkbox if you want to include audio from the
video source file otherwise only audio from files in the additional list will be used.

Select the “Use ‘live’ captions/subtitles from video source file” checkbox if real-time captions
or subtitles are to be displayed during playback. ‘Live’ captions or subtitles do not appear in
the Captions Viewer can cannot be scrubbed.

Select the “Enable pre-processing of captions / subtitles” checkbox if pre-parsing of captions
or subtitles is required. This option must be selected to use the Captions Viewer and to
process external side-car files such as SRT, SCC and XML files. Please note that enabling
this option may cause the media loading time to increase.

Select the “with Deep Scan” checkbox for certain files that do not have caption information
in its header. This option will cause a full scan of the file to locate captions and may take
several minutes to process.

After selecting ‘OK’ to continue, the media package will appear in the Project as an icon with
a thumbnail and some metadata.
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il Projects

Groups Settings Preset Annotations

~ & New Folder
& Project 5
& Project 2

& Project 3
& Project 4
& Test

& test updated project 123 abcdef 114

4.3.15.1.1.1  Options

Store Annotation Positions As:
Frames
Time
® Timecode

Environment Profiles

Cancel Apply

There are two options available. The first one determines how annotations will be stored —
either as frames, time or timecode and the second one allows defining an environment
profile to be used when the asset package is opened. The significance of this is that by
storing as timecode, the position of the annotations is guaranteed to appear in the frame it
was intended for, when working on different versions of a video fie. For example, 2 different
people may be working on 2 versions of a video file where 1 of the video files is of a different
duration to the other due to it being edited. Storing annotations by timecode ensures that
annotation appears on the same scene but storing as time could result in an annotation
appearing on a different scene.

The Environment Profiles setting allows an environment profile to be applied for a given
asset package. The list of environment profiles must already have been added in the Iris
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Admin and the dialogue box below will display the list of Environment Profiles held by the
Iris Admin. Please consult the Iris Admin user manual on adding Environment Profiles.

€3 Asset Package Settings

Annotations Clear

Current Environment Profile:  <unspecified>

Cancel Apply

To assign an environment profile, select the profile from the list and click “Apply” button. To
remove the environment profile, click “Clear” followed by “Apply”.

4.3.15.1.1.2  Play
Selecting this or double clicking the icon will load and play this package.
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€3 Media Files

KE_063014_HD.ts J 63014 HD.ts

Set Files as Master Project Modify ~

This dialog box is split into two halves. The left-hand side shows the original ‘symbolic’ link
of the files that make up the package. The right-hand side shows the current user’s link to
the files for the same package. If there are missing files, then the links will be highlighted in
red. The user can also modify its lists of files for this package by selecting ‘Modify’ and then
selecting a new set of files. To re-assign the current files and settings as the master set of
files so that all other users will see the new symbolic links, select the ‘Set Files as Master
Project’ button.

4.3.15.1.1.3 Upload Package to Server
The project can hold both the ‘symbolic link’ to the package and the entire package on the
Iris service server. You can upload the package to the server so that it can be shared with
other users who do not have access to the symbolic link of the media.

4.3.15.1.1.4 Download Package
If the media package has been uploaded to the server, this menu allows the user to bring
the entire package back to their local machine.

4.3.15.1.1.5 Cut
Copy to clipboard and delete this item on successful paste.
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4.3.15.1.1.6  Copy
Copy item to the clipboard.

4.3.15.1.1.7 Delete
Deletes the entire package. If the media also exists on the server, it will be deleted if there
are no other projects referencing the media.

4.3.15.1.1.8 Rename
Changes the package name.

4.3.15.1.1.9 Refresh Thumbnail
Clears saved thumbnail for this package and rebuilds a new image.

4.3.15.1.1.10 Add/ Edit Description
The default description is the basic metadata for the video source file. User can overwrite
this description.

4.3.15.1.2Sorting
The media packages in the projects can be sorted. Right click the project window to bring up
the project context menu and select the criteria to sort on. The sort order can also be
specified.

2BROKE_063/

Add Package
Sort Sort Order

Asset Name

File Name
Refresh All Thumbnails
File Size

Reload this Project Display Width

Display Height
Frame Rate
Total Frames
Video Codec
Audio Codec

CEEEEEEEE LY

Audio Channels

4.3.15.1.3 Search for Asset Media
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ings Presct Annotobons
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H

wrcject (Not in group)

The Search Bar is located below the Projects Tree and enables searching for a folder,
project or asset packages based on name. The left and right arrow enable navigation of
search results allowing for the previous and next match (a match can be either a project or
asset media) to be located. If the previous or next match is a project, then the matching
project is highlighted. If it is an asset package, then both the matching project and matching
asset package will be highlighted.

On the left of the search bar, there is a down arrow button which can be used to perform an
enhanced search. The enhanced search looks like the following:
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gs  Preset Annotations
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ot in group)

With enhanced search, there is the ability to search using the logical operators AND and OR.
This allows Iris to perform search based on 1 or more matches. In the above example, the
search is equivalent to finding a match where the name contains “21” and the name also
contains “Project”.

Note that upon a search being carried out, the Project Tree will only show matched items.
These will be folders or projects whose names match the search string and/or projects who
that contain asset packages whose names match the search string.

4.3.15.1.4Users

PR DR
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Each project can be shared by multiple users. The creator of the project (denoted by a
pencil icon in the first column) can add a user via their email address. Users can be
removed from the project by selecting each user (use CTRL key in conjunction with left
mouse button to select multiple users) and clicking “Remove Selected Users”.

When a user is added to a project, then the user will either use group permissions, if the
user is a member of a group, otherwise the permissions for that user are set to the following
default values and can be modified by anyone with the “Manage Users” permission enabled:

Manage Users No
Manage Projects No
Message Board Yes
Annotation Messages Yes
Annotation Drawings Yes
Delete Messages No
Add Message Attachments No

An invitation link can be generated and copied to the clipboard for pasting into an email to
invite the new user to this project. The link contains information on how to download an Iris
installer and how to join the shared project.

The user can invite new user by adding their email address.

The user can copy the invitation to the clipboard or open an email client to send the
invitation text if one is installed.

3 send Project Invite

Dear sscott@archimediatech.com,

billy Lait <blai@ archimediatech com> would like to invite you to join the
workspace "Iris and the Cliens Reviews -- No Worries 360p".

If you have not installed Archimedia Iris. please download it from
http//support.archimediatech tv.

After you have installed Iris, please click on the link below to open the project.

iris:/localhostworkspacelD=3&loginToBeActivated=sscott?%

40archimediatech com&useCloudService=F alse/Fd9salwHbEGS VaDZZ3SwiPQudua
oGHiaii%2BRS%2F%2FB%

2FGIQoJ8JOPIDWIq6GTHel 1 SjamxNAvhSNa7 0y VKDm Y dGILbTi9kihc HSIH3Dj
DYXehCZb%2Ft%2FX0%

2FITqQUa43hyYVzoVK d8odnhDMAmA5ixR44dWNILJxXSCHqkE%2F8%

2B JKs6AmhEV?62F I SkAvIvz4RaxwyvkdbemNIfrAX%
2BOMvXAbOxTKU153c4%2B0SOohKraYhGeDInSHOpOADXrh Y%
2BVPOb3pCYc%
2FJiDAXVb30sYIGGSCs0KNUhEmz7 g5 Xal OFcd9g72CevVIqOKsdEnMYBuCPk

Copy to Clipboard ~ Open Email Client
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Users’ permissions and their project start and end dates can be modified but if the user is a
member of a group and that group is in the project, then the permissions and the project
start and end times are controlled by the group. This is denoted by a group name being
shown under the column “Controlled by Group Rights”. See section 4.3.15.1.5 for more
information on groups. In the case of a user’s permission being “Controlled by Group Rights”,
the permissions are not editable but the group permissions can be modified in the Iris Admin
GUL.

4.3.15.1.5Groups

Both projects and/or folders can belong to one or more groups and this allows users who
are members of specified groups to be given access.

4.3.15.1.5.1 Folders

A folder becomes a shared folder when it is made available to specified groups. All items in
the shared folder’s hierarchy also become available to group members but note that users
will still need to be invited to projects to view the assets within the projects, even if the
project is in a shared folder. Any user can add their own folders and projects to a shared
folder but items that do not belong to the current user are read-only; that is, they cannot be
deleted, renamed, moved, etc. These read-only folders and projects will be shown with a red
cross at the bottom right as shown below:

a0
% X

Note that only folders at the project tree’s root level can be assigned groups and this
operation can only be carried out if the user has the rights to manage projects.

To add/remove folder groups click on a folder in the project tree and the Groups settings will
appear:
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7 Shared Videos

¥ Project 1

To add or remove a group to the project, click the “Add/Remove groups” button, located at
the bottom. A new dialog box will be shown a list of groups that have been configured in the
Iris Admin GUI. For more information on groups, please consult the Iris Admin User Manual.

~

Group 2
Groupd
NewGroup
Tes

4.3.15.1.5.2 Projects
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Here, groups can be added or removed from a project. In the screenshot above, a group
called “QC” has already been added to a project and this means users who are member of
the “QC” group have access to the project. Furthermore, such users will inherit the
permissions and the start and end dates of that group. This applies even if a user that is a
member of that group had previously been individually added to a project with individual
permissions and project start/end times. Essentially, if a user is a member of a group, the
group’s permissions and project start/end times take priority over the user’s
individual settings.

The following rules describe how user permissions are used in Iris:

o If the useris not in a group, the users’ permissions can be individually altered in the
Users table (see 4.3.15.1.4).

e If the useris in a group, then the group permissions override the user permissions.
Group permissions can be modified in the Iris Admin GUI.

To add or remove a group to the project, click the “Add/Remove groups” button, located at
the bottom. A new dialog box will be shown a list of groups that have been configured in the
Iris Admin GUI. For more information on groups, please consult the Iris Admin User Manual.
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€Y select Project Group Members

4.3.15.1.6 Project Settings

DEMO PROJECTS

Cut here

Swearing!

nforgettable_2011 (Intl Ep _
3

Each project has a set of common settings. These include the Asset Metadata template
(online shareable templates only), thumbnail position to extract from, color codes and pre-
defined shortcut annotation messages.

4.3.15.1.7 Markers
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Projects

DEMO PROJECTS
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Pre-defined annotation markers can be specified on a per-project basis. Each media file added to a
project will include the pre-defined annotation markers in addition to those that have already been
manually added.

Pre-defined annotation markers are added by clicking the ‘+’ symbol to create a new marker. Each
new marker can be enabled or disabled via a checkbox and its positioning is specified by:

¢ A percentage from beginning or end of the media file

e The number of frames from beginning or end of the media file
e The timecode

e The time from beginning or end of the media file

Furthermore, each marker can be supplied with a color code and a message. These are reflected in
the Annotation Messages tool window.

To delete a marker, click the ‘X’ button that appears on the left of the marker.

4.3.15.2 Work List for Asset Packages
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= Work List for Asset Packages

© created from API id 66) 123

MOM _103014_HD.mpg

The Work List is a pre-prepared list of asset packages given to users of a particular group to
work on. The asset packages in the list are populated via the API and each work list belongs
to a group, hence only users who are assigned to groups will see the work list.

After a user logs in, the first asset package in the Work List will commence playback. To
play other asset packages in the Work List, double click the item. Asset Packages that are
added or removed via the API will be dynamically updated in the Work List. If the asset
package that is currently being played is removed, then playback of that asset package will
end and the first item in the Work List will commence playing.

4.3.15.3 Video

4.3.15.3.1 Vectorscope
This toggles the Vectorscope tool window on and off. This represents the phase
relationship between the Cb and Cr color component of a color difference YCbCr system.
RGB/XYZ formats are not represented in the Vectorscope.
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When the “Errors” checkbox is enabled, pixels that are outside of the 100% boundary
markers are shown in yellow. The limit can be adjusted within the range of -25% to +25%.
A positive value is percentage higher than 100%, a negative value is percentage below
100%. Errors are also logged to the “Timeline” window.

The “Line Range” checkbox when enabled overrides the global “Line Range” settings from
the Video Selection toolbar.

4.3.15.3.2 Spectrascope
This is an advanced feature to display the color space of the video on the CIE 1931
Chromaticity diagram. The sequence of conversion from each color format is as follows:

YCbCr > RGB > XYZ > xyY.

For more details, see
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Line Range

09 Primaries)

The “Line Range” checkbox when enabled overrides the global “Line Range” settings from
the Video Selection toolbar.

Graticules are available for reference color spaces of BT.709, BT.601, CIE RGB, Adobe
RGB, BT.2020 and DCI-P3.

Color Primaries can be automatically detected or manually selected for reference levels.

The trace is displayed in real time as the video is played and the trace can be set to
“accumulate” mode to see the range of colors used across any clip.

The inverse trace on the CIE 1931 “horse shoe” diagram can also to shown.

Format YCbCr - xyY using BT.709 Primaries BT.709

CIERGB

Adobe:RGB

BT.2020

DCI-P3
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The Spectrascope converts the video color space to xyY but it only plots the 2D values of x
and y. The 3™ dimension of Y which is the luminance is omitted because it is difficult to
visualize the “brightness” level of the combined trace. The “Use RGB color” provides a
means of visualizing all three dimensions by plotting the actual RGB color value at the x
and y coordinate. This gives the variations of color value as the video is played.

4.3.15.3.3 Waveforms Monitor
This toggles the video Waveforms Viewer on and off.

The waveform monitor provides a convenient way to visualize the video across the width of
the screen with each line overlaid on top of each other over the time period of one frame.
The markers of 0%, 75% and 100% represent the video levels according to the source file
resolution and its video standard. YCbCr formats are displayed as Y — Luminance (white),
Cb — Blue-Green (cyan) and Cr — Red-Green (magenta). RGB formats are displayed as
Red, Green and Blue.

When the “Errors” checkbox is enabled, levels that are outside of the 100% (White) and 0%
(Black) boundary markers are shown in yellow. The white and black limits can be adjusted
within the range of -50% to +50%. A positive value is percentage higher than white/black
levels, a negative value is percentage below the white/black levels. Errors are also logged to
the “Timeline” window.

The “Line Range” checkbox when enabled overrides the global “Line Range” settings from
the Video Selection toolbar.
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& Waveforms Monitor

The context menu allows the user to select between ‘Auto mode’, ‘Vertical Parade’ or
‘Horizontal Parade.’

W Waveforms Monitor

Errors B

HDR Display
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PQ-BT2020NC TDMB=1200nt MaxCLL=0nt MaxFALL=0nt

When content is encoded with an Electro-Optical Transfer Function (EOTF) of PQ (ST 2084)
or HLG, the waveform display has the additional menu options to show the HDR encoded data
converted into “Light Levels”.

HDR Graticules » Off
v Show Graticules v Auto
PQ Light Level
Mod »
oce HLG Light Level
Size »

HLG Percent RGB

HLG Percent Light Level

For PQ, the light level is defined as nits (cm/d2) and for HLG, it is defined as percentage of

light level. The waveform can display the combined maximum of all three RGB components or as
separate RGB waveforms.
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4.3.15.4 Audio

4.3.15.4.1 Audio Level Meters

|11 Audio Level Meters | Output
8% > > Min 60 3 Max 0 o Step 12

Each meter represents the audio levels of the corresponding output channel. The scale is
calibrated relative to 0dBFS (full scale). A context menu on the window has the option to
display ‘peak hold’ at its maximum detected level.

The controls at the top of the Audio Level Meters tool window allows the number of audio
channel meters on the tool window to be changed and allows scrolling of the audio meters.
The minimum and maximum range can be set from -90dBFS to 0dBFS. The dB steps per

segment can be set from 1 to 6 dB.

4.3.15.4.2 Audio Router Panel
L4 Audio Routing Panel

Audio Channel Input

Each row represents an output channel. Each column represents an input channel.
Selecting a cross-point in the router matrix will route that input to the output. An input
channel can only be routed to an output channel that already exists. A context menu on the
window allows the window to be “Always on top.” Routings could be saved as profiles.
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Input audio channels displayed in blue represents the channels that were created by the
Audio Mixer.

4.3.15.4.3 Audio Mixer
This tool allows the input audio channels to be mixed into mono or stereo for output, for
instance, down-mixing 5.1 audio to the 2 channels of stereo. The resultant mixed channels
will be incorporated into a new audio track available for selection from the Audio context
menu as per Section 4.3.9

The Audio Mixer tool is shown below with the left hand side showing the audio tracks that
will be created as a result of the channel mixing. The right hand side lists the input channels
to be mixed.

{1} Audio Mixer

Mixings Cnly

Ch1 Ch2 Ch3 Ch4 Chs Ché

Cl Ch3 cl o, 6
M S M S M S M S M S M S
Inv Inv Inv Inv Inv Inv Inv Inv Inv Inv Inv Inv
dB d8 dB dB de d

The first step in mixing audio is to create a profile of an audio track that encapsulates the
output audio channels. Click the “+” button to create an audio track (by default it will be
called Mixing n where n is a number):

Version 9.5.1.194
66 llcrAanvETA

© 2024 Copyright GrayMeta. All Rights Reserved.



Iris Play User Manual

11 Audio Mixer
Listen to Mixings Only Mixing 1

Mixings + o

Output Layout :

® Mixing 1 No. of Input Cha

Output Routing :

Create Audio
Track

When the audio track is created it will be called “Mixing n” where n is a number. This can be
renamed by right clicking on the name and selecting “Rename” from the context menu. The
Output Layout will default to “Stereo” and the default mixing properties for stereo will be
applied. This can be changed to “Mono” which will have its own default mixing properties.
The number of input channels defaults to 6 but can be changed to a maximum of 64. The
Output Channels Routing defaults to “None” but this can be changed to a pre-defined pair of
output channels from the drop down list box as shown below:

Mixing 1

Output Layout : =

No. of Input Channels : 6 ¥
Output Routing : _

( Channel 1,2
Channel 34

N Channel 5,6
Channel 7,8
Channel 910
Channel 11,12
Channel 13,14
Channel 15,16

—

02 dB -6.02

Each channel can be muted by clicking the “M” button. A channel can be selected as “Solo”
by clicking the “S” button. When a channel is selected as “Solo”, it means that it is the active
channel and all other channels are muted. To select more than one channel as Solo, hold
down the CTRL key while clicking the “S” button of the required channel.

Individual input channels can be configured by altering the balance and/or loudness. The
amount of signal at the left and right of each channel is represented by a value in dB that
range from 0 dB to - dB. 0 dB on the left implies the balance is 100% at the left and 0% at
the right. Conversely, co dB implies the balance is 100% at the right and 0% at the left. The
balance defaults to -6.02 dB at the left and -6.02 dB at the right. This is equivalent to 50%
left and 50% right. The balance can be changed by rotating the balance control and double
clicking the values of the balance at either the left or right, will reset the balance to its default.
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When setting the balance, the values for each left/right pair of each channel can be set to
invert phase by clicking the “Inv” button. In effect, this changes the downmix from an LoRo
downmix to an LtRt downmix.

The sliders below the balance control can be used to adjust the volume of the channel. On
the far right of the window, there is a “Master” slider. This applies the specified volume to the
result of the mixed channels. Hence, if the sound from downmixing is too quiet, the Master
slider can be used to increase the volume of the downmixed audio.

The “Normalize” button that appears in the Master Slider control can be used to normalize
the audio levels to a ratio of 1.

There are two buttons on the top right. The “Mute/UnMute All” button will mute or unmute all
channels. The “Reset” button will reset all settings.

The settings can be saved to a profile and when saved, those settings can be applied to the
audio track. Therefore, when creating a new audio track, a saved settings profile can be
loaded and those settings will be applied to the audio track. The controls to save and load a
profile appear on the top right of the window.

The Audio Mixer contains a button to “Listen to Mixings Only” which will disable the original
audio track and only play the downlix tracks. In this mode, individual mixing tracks can be
enabled or disabled. The screenshot below shows Mixing 1 enabled and Mixing 2 disabled:

11} Audio Mixer
Listen to Mixings Cnly

Mixings + @

® Mixing 1

4.3.15.4.3.1  Save Audio Mixer Settings

To save the audio mixer settings, click the top right Save button. You will be presented with
a choice of destinations to save to, prior to the save. These are:

e Local — save the settings locally on the computer
¢ Online — save the settings to the database

Version 9.5.1.194
68 BllcrAanvETA

© 2024 Copyright GrayMeta. All Rights Reserved.



Iris Play User Manual

o Group (only applies to logged in accounts) — save to the group in which the current
logged in user belongs to (if applicable).

4.3.15.4.4 Audio Phase Meter
qr Audio Phase Meter | Output

ILeft Right}
Left Right
v 1 w2~ - -
3 wvaw - -
5vgw - -
Anti-ph 7 vg -
9 viov| v
1 12v v
137 14~ Il -

15> 16™ ~

lEIth’ In-Phiase-

The audio phase meter shows the phase relationship between any two audio channels.
There are 8 traces available for display. Each trace can select between any two channel
between 1 and 16. When the two channels are in phase, the trace appears vertically (y-axis).
When the two channels are out of phase (anti-phase) the trace appears horizontally (x-axis).
Predominantly left or right channels appear in the diagonals (45 degree) positions.

4.3.15.4 .5 Audio Waveforms

Analyse % Min 96 T Max 0 y  Color1 ~ Color 2
Offset: 0 frames Frame Start: 742.775s  |Frame: 22262 Frame End: 742.809s Total Time: 1635.434s
rack 7
Mode
Integrated
Loudness Range
Momentary Max
Short Term Max

True Peak

Sample Peak

The Audio Waveforms window shows the analog waveform across the channels at the same
time position. The center position of the green dotted line represents the top of the current
frame, and the yellow dotted line represents the end of the current frame. The distance
between the green and yellow markers represents the period of 1 frame. The scale can be
zoomed in and out by the use of the + and — buttons on the horizontal scroll bar. The
number of channels to display on the screen can be zoomed in using the + and — buttons on
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the vertical scroll bar. The context menu allows the switch between the input and output
channels and the levels in linear or dB scale (from 0dBFS to -96dBFS).

On the left-hand side of the Audio Waveforms window are the loudness levels of each input
track. This represents the levels measured at the input to the router. The loudness
measurement mode (EBU-R128, BS1770-1 etc ) is set up in the Options box based on the
channel layout (2.1, 5.1,7.1 etc) of the track. The output loudness, measured at the output of
the router is configured in “Options->Loudness->Speaker Config for Output Loudness
Measurement” and can be selected for automatic or manual channel layout. In automatic
mode, if the channel layout is not specified in the metadata, the number of channels will
map to a default mapping up to 16 channels as below:

1: 1.0 (FC) mono
2: 2.0 (FL, FR) stereo

3:3.0 (FL, FR, FC)

N

- 4.0 (FL, FR, SL, SR)

(&)}

:5.0 (FL, FR, FC, SL, SR)

6: 5.1 (FL, FR, FC, LFE, SL, SR)

7:6.0 (FL, FR, FC, SL, SR, BL, BR)

8:7.1 (FL, FR, FC, LFE, SL, SR, BL, BR)

9:71 (FL, FR, FC, LFE, SL, SR, BL, BR, nu)

10: 7.1.2 (FL, FR, FC, LFE, SL, SR, BL, BR, LTM, RTM)

11: 7.1.2 (FL, FR, FC, LFE, SL, SR, BL, BR, LTM, RTM, nu)

12:7.1.4 (FL, FR, FC, LFE, SL, SR, BL, BR, LTF, RTF, LTR, RTR, nu)

13: 7.1.4 (FL, FR, FC, LFE, SL, SR, BL, BR, LTF, RTF, LTR, RTR, nu, nu)

14: 714 (FL, FR, FC, LFE, SL, SR, BL, BR, LTF, RTF, LTR, RTR, nu, nu, nu)
15:7.1.4 (FL, FR, FC, LFE, SL, SR, BL, BR, LTF, RTF, LTR, RTR, nu, nu, nu, nu)
16+:9.1.6 (FL, FR, FC, LFE, SL, SR, BL, BR, WL, WR, LTF, RTF, LTM, RTM, LTR, RTR)

Only a maximum of the first 16 channels are used for loudness measurement. “nu” means
“not used”.
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The loudness measurement parameters are as follows:

¢ Integrated (also known as Program Loudness) — the average loudness of the entire
audio.

o Loudness Range — Specifies the overall range of the audio levels from the quietest
part to the loudest part.

e Momentary Max — For each 400ms window of time (called a “Momentary Window”),
the maximum loudness is taken. The greatest of all these values taken over the
entire duration of the audio is the “Momentary Max”.

e Short Term Max — For each 3000ms window of time (called a “Short Term” window),
the maximum loudness is taken. The greatest of all these values taken over the
entire duration of the audio is the “Short Term Max”.

o True Peak — The loudest value of all inter-sample peaks (4 times over-sampled) over
the duration of the audio across all channels. To view the peak values for each
channel, enable the “Show Loudness Overlay” context menu to see additional
information.

¢ Sample Peak — The loudest value of each digital sample of audio over the duration of
the audio across all channels. To view the peak values for each channel, enable the
“Show Loudness Overlay” context menu to see additional information.

Loudness will be measured from the “Mark In” to the “Mark Out” cursors (see 4.1.1)

The task bar buttons provide quick access to the loudness settings in the Options box,
adjustment of the minimum and maximum values of the waveform and colors between 2
adjacent tracks for easier identification of tracks.

4.3.15.4.6 Audio Loudness Monitor
Whereas the loudness measurements of the Audio Waveforms Window in section 4.3.15.4.5
applies to the entire duration of the audio, the Loudness Monitor provides loudness
measurements of the audio in real time. Therefore, the measurements are based on
loudness levels up to the current position during playback.
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Track 1 MOM_103014_HD.mpg (6-Chn 0-bits 48000Hz English Dolby Digital (AC-3))~ Q oD @Freeze B @

EBU-R128 5.1 arget Loudness True Peak Threshold Dialnorm (-27 dBFS
20

Short T

-26.5 we

Momentary i
-25.5 ws
Loudness Range

3.0

On the left-hand side are the loudness measurements of which are described in the Audio
Waveforms Section (see 4.3.15.4.5). Additionally, there are two further measurements —
“Short Term” and “Momentary”. “Short Term” describes the maximum loudness within the
past 3000ms (called the “Short Term” window). “Momentary” describes the maximum
loudness within the past 400ms (called the “Momentary” window). The Integrated Loudness
measurement will turn red when its value is outside the range specified by the Target
Loudness and its tolerances. For example, for a Target Loudness of -24 LKFS and a Target
Loudness Tolerance of +2 and -2 LKFS (giving a range of -22 LKFS and -26 LKFS), the
Integrated Loudness will be shown in red if it is outside the range between -22 LKFS and -
26 LKFS.

The graph represents the different types of loudness measurement with each line of the
graph being color-coded corresponding to the colors of the loudness measurements on the
left. For example, the yellow line on the graph represents Momentary loudness. Individual
lines on the graph can be toggle on and off by clicking the graph icon for each loudness
measurement on the left hand side.

Dotted lines on the graph represents certain limits that are of interest. The legend at the top
of the tool window specifies the meaning of the dotted lines.

If viewing the input tracks, a drop-down list will appear to allow selection of the track to
monitor. If viewing the output channels, the channel layout and measurement mode will be
defined by the option “Options->Loudness->Speaker Config for Output Loudness
Measurement”.

4.3.15.4.6.1 Loudness Monitor Toolbar Icons
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There are various icons available on the top right:

@ Q ) @Freeze B @

The first 2 buttons allow zooming in and out of the horizonal time scale.

The 3" button resets all loudness measurements. This is useful when measuring the audio
loudness starting from a certain position. For example, if the user wishes to start measuring
the loudness starting at 20 seconds into the audio, click the reset button while the playback
position is 20 seconds into the audio.

The 4" Freeze button pauses loudness measurements. This is a toggle button therefore
clicking it again un-pauses it.

The 5" button provides quick access the Options box (as described in 4.3.15.4.5). In the
Options->Loudness page, the Historical Period defines the number of seconds to keep
history of loudness measurements. The Loudness Axis Range specifies the minimum and
maximum loudness to show on the vertical scale of the graph. Display Value Decimal Place
specifies the accuracy of the loudness values to a specified number of decimal places.

As with the Audio Waveforms Window (section 4.3.15.4.5), the loudness measurements are
based on algorithms such as EBU-R128, A85/BS1770-1 and A85/BS1770-2 standards (or
based on a custom profile). The Loudness Measurement settings are described in the Audio
Waveforms Section 4.3.15.4.5.

The 6™ “?” button provides help on mouse and shortcut key navigation around the graph.

Controls
Zoom: BB o @abutons or [N+ Mousewheel

Pan: _,r‘ Right arrow [EEeTaEENe|[+ETs

E Double click

Copy bitmap : +

4.3.15.5 Captions/Subtitles
There are two types of captions/subtitles tool viewers — Live Captions/Subtitles Viewers and
Pre-processed Captions/Subtitles Viewers:-

Version 9.5.1.194
73 BllcrAanvETA

© 2024 Copyright GrayMeta. All Rights Reserved.



Iris Play User Manual

Projects

Video 3

Audio 3

Captions/Subtitles » Live Captions/Subtrtles Viewers
Annotations * PreProcessed Captions/Subtitles Viewers

Aszet Metadata
Playlist

Status Panel

Woehler Tachyon Wormhaole

4.3.15.5.1Live Captions/Subtitles Viewer

The Live Captions/Subtitles Viewer shows the caption/subtitle text at the current position
of video playback. Only text is shown and positioning, colors, fonts and other attributes
are ignored. There is one viewer for each subtitle format (608 CC1, 608 CC2, 708
Service 1, 708 Service 2, XDS, etc). During video playback, subtitles/captions of each
format will appear in the corresponding Viewer. Each Viewer can be opened in the Tools
context menu as shown below:

Projects

Video 3

Audio 3

Captions/Subtitles » Live Captions/Subtitles Viewers Enable Viewers
Annctations » PreProcessed Captions/Subtitles Viewers

608

708

Asset Metadata
Playlist

Status Panel

Wohler Tachyon Wormhale

The Viewers can be disabled or enabled by checking or unchecking the “Enable Viewers”
option in the context menu.

There are two modes of operation in the Live Captions/Subtitles Viewer. The default
mode of operation is to show the time and text at the current playback position. The
screenshot below shows the time and text for 608 CC1 captions.
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Live Captions / Subtitles Viewer (608 CC1)

Time: 00:00:20.487

Immigration
retirement party.

The second mode of operation is to use “History View”. History View can be enabled or
disabled by right-clicking the viewer and enabling or disabling the “History View” menu
option. The screenshot below shows the viewer set to History View along with various
options in the context menu.

Live Captions / Subtitles Viewer (608 CC1)

Hola.
Boy. that’s good scotch.
What a waste. Ugh.
What is wrong with thes
Why can't Hector do it?
Immigration Histary View
retirement party]
00:0( 2 Half the kitchen JEUSEES gl
in the freezer. ¥ | Autoscroll
00:00:24.224 Got it
00:00:27.494  Hola. Clear
00:00:31.865 Boy, that's good it eCEE IR JIERELL

00:00 / What a waste.
Fontsize

00:0( What is wrong w
00:00:44.2

The Live Captions/SubtitlesViewer context menu consists of the following options:

e History View — toggles History View on and off

o Set Active — the subtitle format of the Live Captions/Subtitles Viewer will be used
as the current format for display in the player

e Autoscroll — Enable or disable automatic scrolling of History View

e Clear — Clear the contents of the Viewer (History View only)

e Clear on File Change — Clear the contents of the Viewer upon loading of a new
video file

e Fontsize — Change the font size to small, medium or large

Version 9.5.1.194
75 llcrAanvETA

© 2024 Copyright GrayMeta. All Rights Reserved.



Iris Play User Manual

4.3.15.5.2 Pre-processed Captions/Subtitles Viewers

The option to display pre-processed Captions/Subtitles Viewers under the “Tools” context
menu work in the same way as described in Section 4.3.10.3 except that when selected
under the “Tools” context menu, the selected captions/subtitles do not become active i.e.
they do not replace the existing on-display captions/subtitles as being the currently active
one. Captions/Subtitles Viewers can be enabled and disabled from within this context
menu by toggling the “Enable Viewers” option.
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4.3.15.6 Annotation

4.3.15.6.1 Annotation Toolbox

Annotation Toolbox allows user to annotate a video frame with objects such as
rectangles, ellipses, lines, arrows and text. Each object can be displayed in a
specific color by choosing from the color drop down list box. Furthermore, except
for text, each object can be drawn with specified line thicknesses and styles from
the respective drop down list boxes. Annotation Mode is enabled when a video
file is opened.

Selection of objects is carried out by enabling “Pointer Mode” by clicking on the
“Pointer” icon and clicking an object. Pointer Mode is enabled by clicking the
Pointer icon and disabled by clicking the same icon. Selected objects can
subsequently be cut, copied, pasted or deleted via the icons in the Annotation
Toolbox or right clicking the selected object and using the context menu that
appears. Selected objects can also be moved by clicking that object and moving
it around with the mouse left button pressed down. Furthermore, multiple objects
can be selected by pressing the Control key and clicking the objects. All the
functionality mentioned in this paragraph also apply to multiply selected objects.

S
P
A
N
O
@)
/ﬂ

It is possible to save an annotated frame using the Annotation Toolbox. The
leftmost floppy disk icon represents “Save” and the adjacent floppy disk icon with
a pencil represents “Save As.” Permitted saved formats are jpg, png and bmp. The icon
to the right of “Save As” allows the current annotated frame to be copied to the clipboard
as an image and subsequently can be pasted into any application that supports pasting
of images.

The Annotation Toolbox can be docked on the top, left, bottom or right by right clicking on
it and selecting the required docking position from the context menu.

4.3.15.6.2 Annotation Messages

An annotation is a collection of textual and/or drawing objects referenced by a frame
position. The left-hand pane contains the list of annotations. Each annotation in the list
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has a priority (represented by a colored rectangle), segment data (depending on the type
of annotation), start time, end time, duration and number of unread messages. The
segment data is used to indicate something of interest but this is only applicable if the
annotation is of the Segment Data type. The drop down list box on the top left can be
used to switch between Segment Data annotations or standard annotations (which do not
have a Segment Data). See section 4.3.2.5 on how to import segment data annotations
into a project.

The right pane shows the users in the project and their messages in a conversation,
which can be filtered by selecting which user’'s messages to display. To start a new
annotation, scrub the video to the frame you wish to annotate and then click the ‘+’ button
on the top right of the annotations pane. Text or drawing objects can be added at this
position. Single clicking of an individual annotation in the list displays the conversation for
that annotation. Double clicking the start or end time will cause the play back to pause
and then jump to position clicked (same as clicking the diamond markers on the seek
bar). Clicking the left and right arrow icons on the top right allows for navigation to the
previous and next annotation respectively. This functionality is also replicated via the left
and right arrow icons of the diamond markers on the seek bar. The conversation in this
window is ‘live’ so any users in the list who are also online will receive the message
instantaneously.

The start, end and duration can be modified by using CTRL + double click which sets the
controls in edit mode. This allows the times to be changed. The priority can be changed
by right clicking the colored priority indicator and choosing a new one from the list.

4.3.15.6.2.1 Share Annotation

Select this item to share a link to this annotation. The link contains information for sign
in, project and annotation position.

& Share Annotation
Hi,

billy lai <blai@archimediatech.com™ shared a link for the project "New Project” at annotation
#81799.

Please click on the link below to view the annotation.

iris-//g5solo/projectiD=4&frameNo=81798 &useCloudService=False Fd9salwHbEGSVaDZZ
3SwiPQuduaoGHiaii%2BftS%2F%2FB%

2EGIQoJ8JOPDbBvy4IA 1 GwluFEuTrZquNyP4VI%2BL d%2Bxb%
2F2Xrp716kwgNsCu9758nVagynCZ3ESc8RezGFimXu3 VDbDGwzmaUS{P 1 Untj7Rzibsn
COZfItQmHwQNBIS 6] YIahHR oHgsf%62BwVvm%
2FaYPa0UUnSXtFSVeliJSpJLwpu3g®%3D%3D

Regards.
Support@archimediatech.com
Archimedia Technology. Inc.

Copyto Clipboard ~ Open Email Client  Close

4.3.15.6.2.2 Copy

Select an item of text or attachment in the window to copy. CTRL+C is the shortcut key.
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4.3.15.6.2.3 Paste from Clipboard
Paste from the Clipboard. CTRL+V is the shortcut key. Any item in the clipboard
including documents, images or simple text can be pasted into the window. This window
also supports drag and drop of files from Windows Explorer.

4.3.156.6.2.4 Capture Video Frame
Captures the current video frame and save it as an attachment in this window.

—\? ﬁi
Uploading 63%

4.3.15.6.2.5 Reload Messages
Reloads the messages.

4.3.15.6.2.6 Enter key to send
Setting to send if enter key is pressed.

4.3.15.6.3 Message Board

Message Board

v

—

v E Man Pang <man@gr

v E cyrus ch of
r 3 fz 7 <{T:

The message board is a general chat window that is applicable to the entire media
package. It also contains a log of events performed by each user. The window is very
similar to the annotation window in that it is a ‘live’ chat window and supports drag and
drop of attachments (if the FTP service is enabled). Messages can be filtered by users.
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4.3.15.7 Asset Metadata

Asszet Metadata
Template : Z4

Audio Trac
Timecode Track Co
Subtitle Track

Filename \Archimedia Samplesh,
Stored Width

Stored Height

Display Height

isplay Height

Jisplay Aspec
Frame Rate
Total Frames

Scan M

Color 5

Color Bit Depth

Frame Layout Progressive
Field Dominance Top field first

Average Bitrate 5242210

A list of the media package’s metadata is displayed in this window. Users can save the
current metadata values as a template which can then be used to compare against other
media packages. Any differences in the data will then be highlighted in red.

4.3.15.7.1 Format specific metadata
Some formats contain extended metadata that will only appear when loaded. These
include Dolby Vision XML, Dolby Digital Plus, Dolby E and other specific formats. A new
node will appear under their respective Video, Audio, Caption or Timecode track
information. Expand the node to view the additional information.

Audio Measured Loudness

If enabled in “Options->Loudness->Enable loudness measurement of audio tracks in Asset
Metadata”, the loudness for each input track will be measured as a background task. The
entire duration of the track will be measured, ignoring the mark in and out positions. When
complete, the “Integrated” loudness will appear at the node level. Expanding the node will
display the other loudness parameters.
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Measured Loudness -14.7 LUFS

Mode EBU-R128 (4.0)
Integrated

Loudness Range 17.1
Momentary Max -1.6

Short Term Max -11.6

True Peak -11

Sample Peak -1.1

The “Integrated” loudness value will highlight in red if the level exceeds the target loudness
set by the measurement mode.

Audio Detected Language

If enabled in “Options->Language Detection->Audio Language Detection”, the spoken
language of the audio data (not from metadata) will be detected as a background task. See
the Options for the GrayMeta Whisper API for more details. When complete, the primary
detected language and its confidence percentage will appear on the node.

Subtitle / Caption Detected Language

If enabled in “Options->Language Detection->Subtitle / Caption Language Detection”, the
display language of the caption text will be detected as a background task. See the
Options for the GrayMeta Lingua API for more details. When complete, the primary
detected language and its confidence percentage will appear on the node.
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4.3.15.7.2 Creating and editing an Asset Metadata Template (Pen icon button)

= Manage Asset Metadata Validations Template
eatemplate: 4 © * @ & Getting Started with Atlas In 17 Minutes MP4
:  Getting Started with Atlas In 17 Minutes MP4

Equal

+ Audio Trac Equal
+ Timecode Equal

4F 4F 4 4>

+ Subtitle Track Count Equal
Videos ¥
Track1 %

+ Filename
Stored Width Equal
Stored Height Equal
y Height Equal
i Equal
Equal
Equal
Equal

Frame Rate Equal

X X X X X X X X x

AF 4F A 4k 4k AF 4F 4F 4

Total Frames Equal

Progr

Wildcard . f MPEG-4 / MPEG-4 part 10
Unknown

Chroma Sampling

Color Bit Depth X Equal ~

% Progress

+
+
+
+
+
+ D
+ D
+
+
+
+ 5
+ 5
+ V
+ C
+
+
+
+

Average Bitrate Equal -
Audios +
Track1 »
+ Filename
+ Cl % Equal -
+ Audio Wildeard AAC (Advanced Auc
+

Audio Sampling Rate ® Equal ~ 44100 3

For values that have a numeric value, a range or absolute value can be set. For textual
values, a wildcard or absolute value can be set. Other fields may have a drop down of
known values. The template can be saved as a local file or as a shared project template.
Use the Project > Projects > Settings page to set a default template for the entire project.

If a template is stored locally on disk, it must be converted to a network shared template
(cloud icon before the template name) before it can be used in a project. Local templates
can only be used for off-line mode.
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4.3.15.8 Playlist

Playlist

Name : Default

@

Files can be added into the play list. Each file can be played sequentially as one cycle or
as a continuous cycle. Each file may have a mark in and out sequence added along with
caption options, scaling and volume settings. Files can be added by clicking the “Add”
button or by drag and drop from Windows Explorer.

4.3.15.9 Status Panel

Status Panel
1280 x 720 @ p59.94
1280 x 720 @ p59.94
00:23:20.008
84516
48.39 Mbps
8.79 Mbps
84516
N/A
NfA

File Format File format.

Playing Format Play format.
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Total Time Total length of the clip.

Total Frame Total number of frames in the clip.
Video Bitrate Video Bitrate

Audio Bitrate Audio Bitrate

IN/Out Dur Duration between the Mark in and Mark out point.
SDI Errors Number of SDI errors (dropped frames).

Genlock Genlock status of dual Bluefish SDI card in 4K mode
Audio Errors Number of audio errors (dropped frames)

Video Error Number of video errors (dropped frames)

Audio Buffers Number of available audio buffer during playback. Video will stop when the
number is 0.

Video Buffers Number of available video buffer during playback. Video will stop when the
number is 0.

CPU CPU Usage (%)

SDI Card No. Current SDI Card

SDI Channel Current SDI Channel
AFD Active Format Description

AFD Changes Number of times where Active Format Description changed

This shows the current playback status. When there are errors such as dropped frames, that
item will be shown in red.

NOTE Windows bug: If the CPU Usage is always 0, please start a command prompt
(cmd.exe) and then type “lodctr /r”. This will rebuild the performance counter settings to its
initial state.
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4.3.15.10 Timeline

|= Timeline

0:00:00 00:00:41:16 00:01:23:08 00:02:05:00 00:02:46:16 00:03:28:08
I
¥ \Video
¥ Audio
¥ Subtitles Audio
¥ Markers

Video

Subtities

Markers

List of series of markers (e.g. Segment indicators in DCP/IMF, Dolby Vision markers from
metadata) are shown in Timeline window. The right side panel which is collapsible is used to
show detail information of markers.

4.3.15.11 Video Selection Toolbar
Sign In

Line Range All -

This toolbar allows the global selection of the line range to process for the video waveform,
vectorscope and spectrascope tools. Toggle the “Pen” icon to see a green (start) marker
and yellow (end) marker overlaid on the video.
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-
— J

& Line Range Range ~ 289

The markers positions can be adjusted by hovering the mouse over the green or yellow
dotted marker and then grabbing the marker and dragging it up or down. They can also be
adjusted by setting the line numbers directly in the number controls. The first active is
numbered as 0.

4.3.16 Toolbar
The toolbar, located on the title bar, provides single-click operations to enable/disable tool
windows.

< B3O N C %

From left to right, the icons in the Toolbar represents:

e Open File window.

e Projects tool window.

e Vectorscope tool window.

e Spectrascope tool window.

¢ Video Waveforms Monitor tool window.
e Audio Level Meter tool window.

¢ Audio Routing tool window.

e Audio Mixer tool window.

¢ Audio Phase Meter tool window.

e Audio Waveforms tool window.

¢ Audio Loudness Measuring tool window.
e Asset Metadata tool window.

e Playlist tool window.

e Timeline tool window.

e Status Panel tool window.

Version 9.5.1.194
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e Pre-processed Captions/Subtitles Viewers window.
e Live Captions/Subtitles Viewer window.

e General and Instant Messaging tool window.

e Annotations editor toolbar.

¢ Video selection toolbar.

4.3.17 Environment
4.3.17.1 Docking Layout

4.3.17.1.1 Manage Docking Layout

Manage docking layout
. g g lay

[T Simple revie
[T Auc

This option allows the user to create a new window layout based on the current window
positions, overwrite an existing layout with the current window positions, rename a layout
and to delete a layout. To apply, select the layout required then click on the ‘Apply Layout’
button.

4.3.17.2 Environment Profiles

Environment Profiles 3 Load Praofile

Save current environment as profile
Instance Sync

Export current envirenment as profile
Display Size »
Import Profile

Tirna Nicrlaw N

An Environment Profile consists of a set of Iris system-wide settings, tool window positions
and sizes, and settings within tool windows. An Environment Profile can be saved, so
different profiles can be loaded, depending on the type of usage. Environment profiles can
also be exported, copied to another computer and then imported from within Iris on the other
computer. Furthermore, Environment Profiles can be associated with the group that the user
belongs to. When a user logs in, if that user belongs to a group that has an associated
profile, that profile will be applied. For more on group-based Environment Profiles please
consult the Iris Admin user manual.

Version 9.5.1.194
87 BllcrAanvETA

© 2024 Copyright GrayMeta. All Rights Reserved.



88

Iris Play User Manual

The list of settings in Environment Profile:

Docking Layout

Audio Mixer settings

Audio Level Meters settings
Audio Phase Meter settings
Audio Waveforms settings
Loudness Monitor settings
Vectorscope settings
Spectrascope settings
Waveforms Monitor settings
Document Viewer settings
Playback settings

Overlays settings

Playlist settings

MXF settings

HDR settings

Dolby settings

DCP settings

DCP / KDM Manager settings
Performance settings

SDI Output settings

DVI/ HDMI / Digital Audio settings
Captions / Subtitles settings
Asset Search Paths settings
Shortcut Keys Mapping

4.3.17.2.1 Load Profile

€% Load Profile

Version 9.5.1.194
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To rename, delete or export a profile, right click on the profile name to bring up a context
menu. Exporting a profile, allows the exported profile to be saved as a file, which can be
copied to another machine and re-imported from within Iris.

4.3.17.2.2 Save Current Environment as Profile

The current Environment Profile (i.e. most system-wide settings, tool windows size and
position, and settings within tool window) can be saved locally or online. Multiple
Environment Profiles can be created this way to allow each profile to be associated with
specific Iris usages. Saving the profile online is only applicable when a user is logged in
because online saving is user-specific.

4.3.17.2.3 Export Current Environment as Profile

Use the export to save the environment profile as a file with the extension “.profile”. This file
can be copied to another machine and re-imported from within Iris on the other machine.

4.3.17.2.4 1mport Profile

A previously exported profile can be imported using this option.

4.3.18 HDR Simulation

These settings allows for HDR Simulation. They are a repeat of the HDR Simulation settings
in the Options Page. Please consult section 4.3.22.9.1 for an explanation of the settings.

4.3.18.1 Dolby Vision® Target Display

This menu will only appear when HDR Simulation is set to Auto and the file is a Dolby Vision
mastering file. Select one of the target display devices to simulate and Iris will apply all
necessary content mapping and trims defined by the metadata.

HDR Simulation > Off
v Automatically render HDR content using metadata
Control >
Force to PQ (ST2084)

Capture Image to Clipboard » Force to HLG (Hybrid Log Gamma)

Copy Current Position to Clipboard
Dolby Vision Target Display » | v 100-nit, Rec.709, BT.1886, Full

600-nit, P3/D65, ST.2084, Full
600-nit, Rec.2020, ST.2084, Full
1000-nit, P3/D65, ST.2084, Full
1000-nit, Rec.2020, ST.2084, Full
2000-nit, P3/D65, ST.2084, Full
2000-nit, Rec.2020, ST.2084, Full

Options

Help »

Alt+F4

Exit
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4.3.18.2 Dolby Vision® Display Management

This menu will only appear when HDR Simulation is set to Auto and the file is a Dolby Vision
HEVC stream. Select one of the Display Management formats to simulate and Iris will apply
all necessary content mapping and trims defined by the metadata.

Environment

HDR Simulation off

v Automatically render HDR content using metadata
Control
Force to PQ (5T2084)

Capture Image to Clipboard Force to HLG (Hybrid Log Gamma)

Copy Current Position to Clipboard
Dolby Vision@ Display Management SDR, 100nits, BT.709, 8bits

Options SDR, 100nits, BT.709, 10bits
HDR, 600nits, BT.2100, 10bits
HDR, 600nits, BT.2100, 12bits
Alt+F4 HDR, 1000nits, BT.2100, 10bits
HDR, 1000nits, BT.2100, 12bits
HLG, BT.2100, 10bits

Help

00:00:04.713 HLG, BT.2100, 12bits

00:00:04:17 . . .
01:00:04:17 . . . HDMI pass through to TV

114

Select ‘HDMI pass-through to TV’ to view the content on a Dolby Vision capable television
or monitor attached to the PC graphics card’s HDMI port. After selecting this menu, playback
must be restarted. The picture will appear pink and yellow on the PC display, this is normal
and not corrupted. To view on the TV, full screen the video by using the menu ‘Display Size-
>Full Screen->Monitor x’ where x is the monitor number with the attached Dolby Vision TV
(Primary monitor is always 0).

Also in this pass-through mode, if there is an AJA Kona 4 or 5 SDI card installed in the
system, a Dolby Vision capable television or monitor can be attached to its on-board HDMI
port and it will also display native Dolby Vision content correctly. The SDI operation does not
require the PC display to be in full screen mode.

IMPORTANT NOTE: For this release, there are some known limitations listed below:

1. Supported graphics card is Nvidia GTX-1070 or newer.

2. Nvidia driver version 419.67 or newer for Window 10/11.

3. Exiting from PC full screen operation, the HDMI port does not turn off Dolby Vision
mode correctly, hence the Windows desktop does not reappear and the TV will go
black. This implies that a minimal of 2 monitors must be used, a primary monitor
for the Iris application and the Dolby Vision TV as the secondary on a HDMI port
(Display Port, DVI, VGA will not work). This is a bug in the Nvidia driver and needs
to be fixed by Nvidia.

4. In order for the AJA Kona 4 or 5 HDMI port to work in UHD/4K correctly, the SDI
option ‘Two sample interleave’ must be enabled for driver version 15 or higher.
This is a limitation in the AJA firmware.
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4.3.19 Control

4.3.19.1 Video Controls

Video Controls

Audio Controls
Tool Windows
Options...

File Properties...
License Information...

Import License...

Help...
About...

4.3.19.2 Pause

Freeze playback of the video.

4.3.19.3 Rewind

Pause Ctrl+5pace
Rewind Ctrl+Left
Play Ctrl+P
Fast Forward  Ctrl+Right
Stop Ctrl+5

Previous  Ctrl+5hift+Left
Mext Ctrl+Shift+Right

Set Mark-In Ctrl+I
Set Mark-Cut Ctrl+ U
Loop Mode

Rewind the playback. Support the following speeds: 2x, 4x, 8x, 16x, 32x and 64x.

4.3.19.4 Play

Begin playing the video.

4.3.19.5 Fast Forward

Fast forward the playback. Support the following speeds: 2x, 4x, 8x, 16x, 32x and 64x.

4.3.19.6 Stop

Stop the playback and reset position to the beginning.

4.3.19.7 Set Mark in

Set the current play head position as the Mark in.

4.3.19.8 Set Mark out

Set the current play head position as the Mark out.

4.3.19.9 Loop mode
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- E ~
Set Mark-Out Ctrl+L

Loop Mode b Mo Loop

Loop All

Loop Once

Enable/disable the playback of loop mode.

4.3.19.10 Audio Controls

Audio Controls ' | Increase Volume Alt+Up
Tool Windows » Decrease Volume  Alt+Down

) Mute Alt+Delete
Opticns...

4.3.19.11 Increase Volume
Increase the volume.

4.3.19.12 Decrease Volume
Decrease the volume.

4.3.19.13 Mute / Unmute
Mute/unmute the audio.

4.3.19.14 Instance Sync

€3 Instance Sync Manage

¥ Running Not Cor
Port No : IP Address

Na. of Connected Instances: 0 Port No :

Connect

Instance Sync allows synchronization of video playback with 2 instances of Iris. In particular,
when the video is playing, paused or scrubbed, another instance of Iris will replicate this. To
achieve this one instance of Iris is the “master” and the other is the “slave”.
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The above dialogue allows the IP address and port number of another instance of Iris to
sychronize its play, pause and scrubbing. In essence, it is instructing another instance of
Iris to be the “master” as that will be the instance of Iris that will take control. To
determine the port number of the “master”, launch the same Instance Sync dialogue on the
master and observe the port number in the “Host section.”

The Host port number can be changed by stopping the synchronization service (click the
stop button), and then changing the port number, then clicking the start button to restart the
service.

4.3.20 Capture Image to Clipboard
Capture Video to Clipboard [ Windowed Size
Full Size

Use this option to capture the current video frame as an image to the clipboard. The image
can be pasted to any application that supports pasting of images.

There are two ways to capture the current video frame — windowed size and full size.

4.3.21 Copy Current Position to Clipboard

Use this option to copy a textual representation of the current video position to the clipboard.
Depending on the current setting, this will be a time, timecode, CTC or frame number.
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4.3.22 Options
System options for the player.

£2 Options

General
Playback

: Settings apply for all users on this machine
Overlays

Custom Video Scaling Check for updates

Playlist Do not show sign in dialog on startup

Loudness

MXE Close dialog after position search

HDR Default Background Color :

Dolby®

D Temp Folder : Browse

DCP / KDM Manager

Performance

SDI Output - ctam Sten Re Eorwa

DVI / HDMI / Digital Audio -~

Captions / Subtitles CustomStep 1 Frame ~ 10 5

arch Paths

Mapping

Server Settings

Custom Step 2: Time v : min ¥

Custom Step 3 : Frame ~ =

Default A
Input

® Qutput

Default Color R
® From Metadata
Limited Range
Full Range

Full JPEG Range

Import Settings Export Settings 0 Cancel

4.3.22.1.1 Settings apply for all users on this machine
When checked, all settings are stored in the C:\Users\Public\Documents\GrayMeta\lris
folder, otherwise the settings are stored on a per user basis in
C:\Users\XXX\AppData\Roaming\GrayMeta\lris.

4.3.22.1.2 Check for update
Notify user when a newer version is available online.

4.3.22.1.3Do not show sign in dialog on startup
Enables or disables the sign in dialog on startup.

4.3.22.1.4 Close dialog after position search
When enabled, the time code search window automatically close after a search.
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4.3.22.1.5 Default Background Color
Choose the background color.

4.3.22.1.6 Temp Folder
Choose Iris temporary folder. Certain processing within Iris requires a fast and large local
drive to store temporary data to improve performance. If blank, the system default
temporary location is used.

4.3.22.1.7 Custom Step Rewind / Forward
Define up to three different shortcuts for stepping back and forth in the video player. Each
shortcut can be mapped to a keyboard shortcut.

4.3.22.1.8 Default Audio Source
This specifies whether loudness measurements will be taken at the input or output of the
audio source.

4.3.22.1.9 Default Color Range for Graticules and Tools
Sets the default setting for waveform, vectorscope, spectrascope, HDR line range, HDR
histogram and other tools that have graticules. Each tools can be overridden by selecting
options in their own menu.
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4.3.22.2 Playback option

%Y Options

General

Playback

Overlays

Custom Video Scaling
Playlist

Loudness

Language Detection
MXF

HDR

Dolby®

DCP

DCP / KDM Manager
Performance

SDI Qutput

DVI / HDMI / Digital Audio
Captions / Subtitles
Asset Search Paths
Shortcut Keys Mapping
Server Settings

Import Settings ~ Export Settings

Enable PC display

Play immediately on load

Resume playback after scrubbing

Resume playback after selecting annotation

Swap interlace

Swap field order

Force Interlace for 1080p25/29.97 in AVI and MOV files
Show bad frames

Show D10 VANC lines (on PC Display)

v Show alpha channel transparency as

Interlace Jog Mode:  pixed fields

Scaling Mode : Auto

Display frame number offset :

Force TCR to striped (contiguous mode)

Control Time Code (CTC)

Hour  Min Sec  Frame
- - w0

0 0 0
Use TCR as start value if available
Use drop frame time for auto timecode track

Use extended frame count for video with frame rate greater than 30 fps

Always prompt for frame rate
® Prompt only when frame rate is not found in file
Never prompt if frame rate is not found and use default frame rate

Always override frame rate with default frame rate

Default frame rate:  23.98 ol [

¥ Enable audio during fast shuttle
Audio Delay / Advance
® Frame Offset: 0 % frames

Time Offset : ms

Audio output device:  Default Sound Device

¥ Enabled

Mode :

4.3.22.2.1 Enable PC display
Allow video output on PC display.
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4.3.22.2.2 Play immediately on load
Start playing video automatically after file is loaded.

4.3.22.2.3Resume playback after scrubbing
Continue playback after scrubbing.

4.3.22.2.4Resume playback after selecting annotation
When selecting an annotation, playback of the video will be paused at the annotation’s
position, if this setting is off. If the setting is on, video will move to the annotation’s
position and will continue playback from that position.

4.3.22.2.5Swap interlace
Swap the interlace order of the picture.

4.3.22.2.6 Swap field order
Reverse the time-order of field 1 and 2. This effectively reverses the ‘Field Dominance’
value specified in the file if any and will also swap the interlace order.

4.3.22.2.7 Force Interlace for 1080p25/29.97 in AVI and MOV files
Force interlace when playing AVI and MOV file with 1080p25/29.97 formats. Some MOV
files in these formats are actually interlaced formats but are indicated as progressive
formats.

4.3.22.2.8 Show Bad Frames
Enabling this option will display un-decodable frames as a grey frame. Disabling this
option skips bad frames effectively repeating the last good frame.

4.3.22.2.9Show D10 VANC Lines (on PC Display)
When content is encoded as SD D10 format (720x512 and 720x608), the top 32 lines of
VANC data can be hidden or shown on the PC screen.

4.3.22.2.10  Show Alpha Channel Transparency
If enabled, content that has an alpha channel will be mixed with the color indicated and
shown on the PC screen. If disabled, no mix is performed and the alpha channel is
ignored, effectively any transparency will be shown as black.

4.3.22.2.11 Interlace Jog Mode
Set the interlace Jog mode (Mixed field, Field 1 only, Field 2 only or alternative field)

4.3.22.2.12  Scaling Mode
Set the Scaling Mode.

4.3.22.2.13 Display Frame Number Offset
This sets the number value of the very first frame. Iris defaults to 1 but other systems
may use 0 to represent the very first frame.

4.3.22.2.14 Force TCR to striped (contiguous mode)
This setting will ensure TCR is contiguous by ignoring breaks in any embedded TCR.
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4.3.22.2.15 Control Time Code (CTC)

Set the starting Control Track Time code (CTC) value for frame 1. The CTC is

always contiguous.

43.22.2.16 Use TCR as Start Value if Available

Enabling this sets the starting Control Track Time code (CTC) to the same value as

the TCR.

4.3.22.2.17  Use Drop Frame time for Auto Timecode Track

Defaults to use drop frame timecode for auto-generated timecode tracks when no

physical timecode track is available.

4.3.22.2.18 Use Extended Frame Count for Video with Frame rate Greater than 30 fps
For video frame rates greater than 30 fps, the default is to show timecodes with a
frame number that is half the actual frame number, suffixed with “*1” to indicate field

1 or “*2” to indicate field 2 as shown below

00:00:02.169 *1

mocnes  (01:00:01:05

131 =1

When this option is enabled, then the timecode is represented as the actual frame

number as shown below

00:00:02.169

BES 01:00:01;10 o o
00:00:02;10 . .

EZE 131

4.3.22.2.19 Frame Sequence (DPX, TIFF, EXR, BMP, JPG, TGA)

‘10

Frame rate options for Frame Sequences: Always prompt for frame rate, Prompt only
when frame rate is not found in file, Never prompt if frame rate is not found and use
default frame rate and Always override frame rate with default frame rate. Sets the

default frame rate.

4.3.22.2.20 Enable audio during fast shuttle

Enable audio during fast shuttle. This only applies to fast forward and fast rewind

modes.

4.3.22.2.21 Audio Delay / Advance
Set the Audio delay or advance relative to the video in frames.
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4.3.22.2.22  Audio Output Device

This sets the PC sound device to use for audio playback. Default uses the assigned
device in the system otherwise select a specific device in the list.

4.3.22.2.23 De-interlacer

Enable or disables the de-interlacer. Bob and Blend are the modes available. The
default (Auto) is Bob.

4.3.22.3 Overlays Option

ea Markers:  Horizontal

Vertical

Width
Height

Opacity :

e

Position : Top
Left
Width

Height

Import Settings  Export Settings

Cancel

4.3.22.3.1 Safe Area Markers

Set the size of the safe area marker for the PC overlay. Both the horizontal and vertical
dimensions of the safe area marker can be set.

Version 9.5.1.194
99 | | llcrAanvETA
© 2024 Copyright GrayMeta. All Rights Reserved.



Iris Play User Manual

4.3.22.3.2 Custom Image Overlays
Allows adding an image (bmp, jpg, png, dib, tga, tif, gif) to be added to the overlay.
Positioning, size and opacity can be changed.

4.3.22.3.3 Custom Text Overlays
Allow text to be added to the overlay. Positioning, size, alignment, font and font attributes,
background color and foreground color can be changed.

4.3.22.4 Custom Video Scaling
This enables custom resolutions to be defined and allows video to be scaled to these custom
resolutions.

£ options

Import Settings  Export Settings

To create a new custom resolution profile, click the “Add” button and fill in the details of the
custom resolution when prompted. Defined custom resolution profiles will appear under the
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Video Scaling context menu option. Use the “Remove” button to remove an existing custom
resolution profile.

4.3.22.5 Playlist

F
L A Y Options

4.3.22.5.1 Playlist
Sets the default mode for the playlist.
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4.3.22.6 Loudness

#Y Options

General
Playback

Import Settings ~ Export Settings

‘alue Decimal Place :

Default Loudness Measurement Standard :

Mono
Stereo

3.0

Custom Loudness Measurement Standard :

Speaker Config for Output Loudnes: asurement :  Auto

¥ Enable loudness measurement of audio tracks in Asset Metadata

Historical Period :

Loudness Axis Range : 70 % to 20 3 LUFS

Audio Source : Default
® Input

Output

EBU-R128
EBU-R128
EBU-R128
EBU-R128
EBU-R128

EBU-R128

A85 BS1770-3/B51170-4

A85 BS177
A85 BS1770-3
AB5 BS177

A85 BS1770-3

A85 BS1770-3/BS

Cancel

Loudness can be measured with or without Dolby Dialogue Intelligence™. Dialogue
Intelligence uses speech-gating to detect dialogue and only measure loudness on channels
where dialogue is detected.

There are a set of options available to specify how loudness is measured and the options
differ depending on whether loudness measurement is using standard loudness or Dolby
Dialogue Intelligence. Standard loudness supports the following standards:

e EBU-R128

e A85/BS1770-1
e A85/BS1770-2
e A85/BS1770-3
e A85/BS1770-4
e Custom setting allowing for customizing parameters that are fixed in the above

standards.
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Each of the loudness measurement standards are based on the following parameters

A85/BS1770-3

EBU-R128  A85/BS1770-1 A85/BS1770-2 and
A85/BS1770-4
Short Term 3000 3000 3000 3000
Window (ms)
Momentary
Window (ms) 400 400 400 400
Target
Loudness -23 -24 -24 -24
(LUFS/LKFS)
Target
Loudness +1/-1 +2/-2 +2/-2 +2/-2
Tolerance
(LUFS)
Gating (LUFS) -10 0 -10 -10
True Peak
Threshold -1 -2 -2 -2
(LUFS)
Use BS1770 3
FIR Filter Yes No No Yes

The following table describes the parameters used in the loudness measurements:

Short Term Window

This is specified as a time window for measuring the past 3000 ms
worth of loudness. It must always be greater than the momentary
window.

Momentary Window

This is specified as a time window for measuring the past 400 ms
worth of loudness. It must always be less than the short term
window.

Target Loudness

This is the threshold in which the integrated loudness (an average
loudness over the duration of the video) would trigger if exceeded.
Target Loudness tolerances can be specified to trigger upon a value
which is within the tolerances. For example, a Target Loudness of -
23 with tolerances of +/-2, will trigger when the integrated loudness
is between -21 and -25.

Gating

This is a value that was introduced to overcome long passages of
silence or low volume noise that can affect the average loudness
over the duration of the video. When the audio level drops below
this value, the loudness measurement will not account for this.

True Peak Threshold

Upon the audio level reaching this value, this will trigger.

In addition to the loudness standards, there is also a custom setting allowing for any of the
parameters in the above table to be set.
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Dolby Dialogue Intelligence supports the following:

e BS1770-1 + Dialogue Intelligence
e BS1770-2 + Dialogue Intelligence
e Leq(A) + Dialogue Intelligence.

In addition to the parameters available for standard loudness, Dolby Dialogue Intelligence
also uses the following parameters:

Speech detection The percentage threshold, from 0 to 100%, at which the

threshold dialogue loudness results will be used as the overall loudness.

True peak emphasis Boolean indicating whether the emphasis filter is used for true
peak measurements

True peak DC block Boolean indicating whether the DC blocking filter is used for
true peak measurements

Standard loudness currently supports up to 5.1 channels and Dolby Dialogue Intelligence
supports 7.1 channels. Each channel requires mapping from the audio source — either at the
input side or output side. This allows requisite audio channels to be specified for use in the
loudness calculations.

The loudness measurements can measure up to 8 channels of audio, either at the input or
at the output. The acceptable channel configurations for measurement are:

Channel Channel(s) used for Loudness Measurement

Configuration

Mono FL

Stereo FL + FR

3.0 FL+FR+FC

4.0 FL+ FR+SL + SR

5.0 FL+FR+FC+SL + SR

5.1 FL+ FR+ FC + LFE + SL + SR

71 FL+FR+FC+LFE+SL+SR+BL+BR

5.1.2 FL+FR+FC+LFE+SL+SR+LTM+RTM

5.1.4 FL+FR+FC+LFE+SL+SR+LTF+RTF+LTR + RTR

7.1.2 FL+FR+FC+LFE+SL+SR+BL+BR+LTM + RTM

714 FL+FR+FC+LFE+SL+SR+BL+BR+LTF+RTF +LTR + RTR

9.1.6 FL+FR+FC+LFE+SL+SR+BL+BR+WL+WR+LTF +RTF +
LTM + RTM + LTR + RTR

The table above shows which channels are used for the loudness measurement where:

e FL = Front left channel

¢ FR = Front right channel

e FC = Front center channel
e SL = Side left channel
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e SR - Side right channel

e BL — Back left channel

o BR - Back right channel

o WL — Wide left channel

e WR — Wide right channel

o LTM — Left top middle channel
e RTM — Right top middle channel
o LTF — Left top front channel

¢ RTF — Right top front channel
o LTR — Left top rear channel

¢ RTR - Right top rear channel

In order to measure the audio loudness (at either the input or output), the audio track’s
channels need to be assigned to FL, FR, C, SL, SR, BL, BR as used by the loudness
measurement. The table below shows the default assignment of the audio source channel
numbers to the loudness measurement channels:

Channel Configuration | Default Channel Assignment

Mono FL = channel 1 of audio track
Stereo FL = channel 1 of audio track

FR = channel 2 of audio track
3.0 FL = channel 1 of audio track

FR = channel 2 of audio track
FC = channel 3 of audio track
4.0 FL = channel 1 of audio track
FR = channel 2 of audio track
SL = channel 3 of audio track
SR = channel 4 of audio track
5.0 FL = channel 1 of audio track
FR = channel 2 of audio track
FC = channel 3 of audio track
SL = channel 4 of audio track
SR = channel 5 of audio track
5.1 FL = channel 1 of audio track
FR = channel 2 of audio track
FC = channel 3 of audio track
SL = channel 5 of audio track
SR = channel 6 of audio track
71 FL = channel 1 of audio track
FR = channel 2 of audio track
FC = channel 3 of audio track
SL = channel 5 of audio track
SR = channel 6 of audio track
BL = channel 7 of audio track
BR = channel 8 of audio track
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The Asset Metadata window and Audio Waveform window can display the loudness of all
input tracks based on the track’s channel layout. Only the Audio Waveform window has the
option to measure the “output” channels (post-router) based on the user assigned “Speaker
Configuration for Output Loudness Measurement”. Measurement channel always starts from
channel 1.

Use the checkbox to enable or disable the automatic loudness measurement for the Asset
Metadata window. For the Audio Waveform window, loudness measurement only occurs
when the window is active and visible.

The remaining parameters in the Loudness Options are Historical Period, Loudness Axis
Range. The Historical Period defines the number of seconds to keep history of loudness
measurements. The Loudness Axis Range specifies the minimum and maximum loudness
to show on the vertical scale of the graph used in the Loudness Monitor Tool Window (see
4.3.15.4.6).

4.3.22.7 Language Detection

7. Options

General

Playback

Overlays

Custom Video Scaling

Confidence Threshold :
Max no. of instances :
Max Duration :

CPU Thread Percent :

DCP / KDM Manager
Performance
SDI Qutput

.y ¥ Enabled

Confidence Threshold :

Server Settings

Import Settings ~ Export Settings D Cancel

Audio Language Detection
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The language of the audio tracks can be automatically detected by processing the audio PCM
data. This requires the “GrayMeta Whisper API” package to be installed in the computer. If
installed, these options will be enabled.

Start Offset — This sets the start offset as a percentage of the duration of the track. This allows
skipping over slates like bars and tone to avoid detection errors.

Model Type — Types include Tiny, Base, Small, Medium, Large, Large V2 and Large V3. Each
type contains trained models for specific languages. The bigger the model type, the more
languages it can detect. See OpenAl’s Whisper documentation for details on which model
supports which language.

Confidence Threshold — A percentage threshold used by the detection algorithm. The smaller the
value, the languages it can detect but with less accuracy. The higher the value, the less
languages it can detect but with more accuracy.

Max no. of Instances — Each track can be processed independently as a background task.
However, since the Whisper process is fairly CPU/GPU (CUDA) intensive, it may affect the
normal operation of playback if more than one instance is used.

Max Duration — The maximum duration in seconds of content to process. Using a combination of
the Start Offset and maximum duration, specific regions of audio can be processed.

CPU Thread Percentage — This sets the maximum number of threads as a percentage to use for
the Whisper API. The actual number of threads is dependent on the physical number of threads
in your system. If a Nvidia graphics card with CUDA capabilities is present in the system, the
Whisper API will automatically use the CUDA hardware and minimize CPU usage and ignores
this parameter.

Subtitle / Caption Language Detection

This requires the “GrayMeta Lingua API” package to be installed. If installed, this option will be
enabled.

Confidence Threshold — This value is used by the Lingua API. The lower the value, the more
languages it can detect but with less accuracy. The higher the value, the fewer languages it can
detect but with more accuracy.
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4.3.22.8 MXF (Material Exchange Format) option

4.3.22.8.1.1  Default MXF timecode track
Select between the Source Package (usually embedded and may be non-sequential) and the
Material Package (Striped and always sequential) timecode track on loading a MXF file.
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4.3.22.9 HDR (High Dynamic Range) option

€3 options

Import Settings ~ Export Settings

4.3.22.9.1HDR Simulation (SMPTE ST 2084 “PQ”")
This option provides a HDR simulation (HDR to SDR conversion) of what the content would
look like on a HDR monitor. The simulation is only available for the PC display. The SDI
output is unchanged so that it can be fed to a HDR compatible monitor.

Off — Turns off all HDR processing for the PC display.

Automatically Render HDR Content using Metadata — Enabling this option will perform a
YCbCr to RGB conversion if the source is YCbCr, then apply an EOTF of PQ or HLG based
on the metadata extracted from the file.

Force to PQ (SMPTE ST2084) - This converts all YCbCr content to RGB and applies the PQ
log gamma correction to perform a HDR to SDR simulation. The default PQ values below
define the LUTs used in the simulation.
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Force all HLG (Hybrid Log Gamma) - This converts all YCbCr content to RGB and applies
the HLG correction to perform a HDR to SDR simulation. The Color Primaries, Mastering
Luminance Maximum/minimum, MaxFALL and MaxCLL are not used for HLG.

Color Primaries — If “Force to PQ’ is selected, this sets the Color Primaries for the PC
simulation and metadata passed to the SDI. Default values for BT.2020/D65, P3/D65 and
BT.709/D65 are provided or user may enter custom values.

Mastering Luminance Maximum — This is the maximum brightness level that the HDR
content was graded at in nits. This value has a maximum value of 10,000 as specified by
SMPTE ST2084.

Mastering Luminance Minimum — This is the minimum brightness level that the HDR content
was graded at in nits. This value has a minimum value of 0.

Maximum Frame Average Light Level (MaxFALL) — This value is not used by the PC
simulation but is passed through to the SDI as metadata. This value is normally obtained by
scanning the entire clip during the mastering process.

Maximum Content Light Level (MaxCLL) — This value is not used by the PC simulation but is
passed through to the SDI as metadata. This value is normally obtained by scanning the
entire clip during the mastering process.

Display RGB Gamma - This is the target PC display gamma for the simulation. Increasing
the gamma produces a brighter picture whereas lowering the gamma produces a darker
picture.

Vivid Mode — For true PQ or HLG simulation this option should be turned OFF. However, the
resultant picture may look rather dull or dark when viewed on a standard BT.709 computer
screen. Enabling this function applies saturation gain and black level shift to enhance the
picture.

Test Split Screen — This is a test feature to allow visual comparison of the original HDR
content (left-side) versus the converted HDR content (right-side).
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4.3.22.9.2HDR Captions
On HDR content, captions can sometimes appear too bright. This option allows the
brightness of the captions to be changed.

4.3.22.9.3HDR Overlay
This section enables the colors of HDR Line Range and HDR Histogram to be specified
(see 4.3.13.11 HDR Line Range and 4.3.13.12 HDR Histogram). There are 2 colors that
can be defined. One of them is the standard color for the HDR Overlay and the other is a
warning color which defines the color to be shown in the event of a warning. The colors
can also be specified with transparency by switching the color picker to the advanced color
picker as shown below:

0

]

]
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4.3.22.10 Dolby®
#¥ Options

General

Playback ~ - . N

i Channel Configuration: Stereo 2.0 ~

Overlays

C m Video Scaling Dynamic Range Compression
® None

Loudness Line (Light compre

Language Detection

MXF

HDR Dolby Atmos® Mastering

DCP

DCP / KDM Manager Audio to Video Alignment

RF (Heavy compression)

Channel Configuration: Stereo 20 ~

Performance #® Align audio to start of video file
SDI Output Align audio to video using "first_frame_of_action” timecode
DVI / HDMI / Digital Audio
ubtitles
h Paths

Dolby E pass-through

Server Settings Mute PC audio
® Decode Dolby E to PCM

Programs  « Program0 + Program1 + Program?2 + Program 3

¥ Program4 ¥ Program5 ¥ Program6  Program 7

¥ Extract Dolby n Metadata

v Validate Dolb on Metadata

Output Levels
Full Range

® |imited Range

Display Management Version: 3.1 ¥

Dynamic Range Compression
® None
Line (-31 LUFS/LKFS)

)

Portable (-11 LUFS/LKFS)
Portable (-14 LUFS/LKFS)

Import Settings ~ Export Settings

4.3.22.10.1  Dolby Atmos®DDP Stream
Channel Configuration — This selects the PCM output channel configuration. The number of
channels is implied by the layout. E.g. 5.1.2 means there are 5 front and surround speakers,
1 LFE and 2 overhead speakers, making a total of 8 channels. Dolby Atmos streams are
carried using Dolby Digital Plus™ (E-AC3) so if Dolby Atmos decoding is turned off, it will fall
back to a 5.1 (6 channel) configuration.

Dynamic Range Compression — Enables dynamic range compression when decoding.

4.3.22.10.2  Dolby Atmos® Mastering
Supported formats include ADM, DAMF, DCP-IAB and IMF-IAB. Select the output speaker
configuration required.
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There is an option to align the audio to the video using the metadata field “First frame of
Action” timecode. Otherwise audio will align with the first frame of video.

4.3.22.10.3 Dolby E™
Dolby E can be set to decode to PCM or passed-through the PC sound device and SDI.
Please note, if Dolby E pass-through is selected, the compressed Dolby E data will generate
full volume random noise on the PC sound device if it does not support Dolby E decoding.
This can be disabled by checking the “Mute PC audio” checkbox. The compressed data will
be passed in the SDI as though it was uncompressed PCM audio.

Eight checkboxes are available for enabling or disabling any of the Dolby E programs.

4.3.22.10.4 Dolby Vision® Mastering
Option to extract metadata embedded in Dolby Vision MXF files and use it for Dolby Vision
simulation. The extracted metadata is formatted as XML and is also displayed in the Asset
Metadata tool window. The metadata can also be validated based on Dolby’s recommended
constraints.

For Iris versions prior to 9.1.0, Iris performs CMU v2.9 simulation but can process v4 XML
metadata and convert backward compatible v2.9 metadata for simulation. XML version 5.x
is not supported. The “HDR Simulation” option must be set to “Automatically render HDR
content using metadata” for processing to occur.

For versions from 9.1.0 onwards, CMU v4 is processed natively without any metadata
conversion. XML version 2.0.5, 4.0.2 and 5.1.0 are supported.

Disclaimer: Due to real time playback performance constraints, CMU v2.9 and v4 processing
does not apply the “Multiscale” sharping filter on the output picture and hence “Iris’ content
mapping preview is not certified for Visual QC of Dolby Vision assets”.

4.3.22.10.5 Dolby Vision® HEVC Stream
Iris can perform HDR simulation of Dolby Vision HEVC streams. Currently only profiles 4, 5
and 8 are supported. Output can be simulated using Display Management version 3.1 or 4.0
to the following target formats (options on main context menu):

“SDR, 100nits, BT.709, 8-bits”
“SDR, 100nits, BT.709, 10-bits”
“HDR, 600nits, BT.2110, 10-bits”
“HDR, 600nits, BT.2110, 12-bits”
“‘HDR, 1000nits, BT.2110, 10-bits”
“‘HDR, 1000nits, BT.2110, 12-bits”

“‘HLG, BT.2110, 10-bits”
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‘HLG, BT.2110, 12-bits”

All formats have the option of “Full Range” (0-1023 for 10-bits) or “Limited Range” (64-940
for 10-bits) output regardless of the input encoded format.

The simulated output can be displayed on the PC display or passed through to a Dolby
Vision capable TV connected via the HDMI port of the graphics card and/or an AJA Kona
4/5 SDI card.

The “HDR Simulation” option must be set to “Automatically render HDR content using
metadata” for processing to occur.

4.3.22.10.6  Dolby Digital Plus™ Dynamic Range Compression
This option selects the dynamic range compression parameters for various listening levels.
Available options are:

¢ None (No compression, full output level)
e Line-31LKFS

e RF-20 LKFS

e Portable -8 LKFS

e Portable -11 LKFS

e Portable -14 LKFS

Version 9.5.1.194
114 BllcrAanvETA

© 2024 Copyright GrayMeta. All Rights Reserved.



115

Iris Play User Manual

4.3.22.11 DCP option

(% Options

General

Playback
Overlays
Custom Video Scaling Assume XYZ Color Space for Frame sequence files (DPX, TIFF, EXR)

¥ Assume XYZ Color Space for DCP files

Playlist XYZGamma: 2600 %

Loudness
NIXE RGB Gamma: 2200 *

HDR
RGB Blac
CP / KDM Manager Red :
Performance Green -
SDI Output
DVI / HDMI / Digital Audio
Captions / Subtitles

Blue :

Red:
Green :

Blue :

Import Settings Export Settings 0 Cancel

4.3.22.11.1  Assume XYZ Color Space for DCP files
Enable XYZ to RGB Color Space conversion for DCP JPEG2000 files.

4.3.22.11.2 Assume XYZ Color Space for Frame Sequence Files
Enable XYZ to RGB Color Space conversion for DPX, TIF, EXR, BMP, JPG, TGA and
PNG image sequences.

43.22.11.3 XYZ Gamma
Set the XYZ Gamma value to use for the conversion. Default is 2.6.

43.2211.4 RGB Gamma
Set the RGB Gamma value to use for the conversion. Default is 2.2.

4.3.22.11.5 RGB Black Offset
Set the RGB black offset value. Default is 0. Increasing this value gives a darker picture.
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4.3.22.11.6 RGB Gain
Set the gain on RGB channels. Default is 100%.

4.3.22.12 DCP/KDM Management

;3 Options

Status : Certificate is Generate Certificate

Status: Universal

DCP / KDM Manager
Performance

Import Certificate

tput Export Public Certificate
DMI Full Screen

.. .
< KDM_ArchimediaEncryptionTest T Status: L Import KDM

o KDM_TinkNeverBeast TST-2D_F-1 Filename: KDM_ArchimediaEncryptionTest TST F EN-XX 51 2K D T —
€ KDM _TinkNeverBeast_T

[ KDM_TinkNeverBeast_T: =

[ KDM_TinkNeverBeast_TST-2D_F-1

[ KDM_TinkNeverBeast_TST-2D_F-1

[ KDM_TinkNeverBeast_TST-2D_F-1

Import Settings Export Settings Cancel

4.3.22.12.1  Certificate
Generate Certificate — This generates a digital certificate tied to this PC only. This
certificate can be passed to the DCP publisher to create the KDM and the DCP will only
be playable on the device that created the certificate.

Use Universal Certificate — This generates a Universal certificate for Iris and the KDM
and DCP content can be played on all Iris applications.

Import Certificate — Allows import of a certificate created by a 3™ party.

Export Public Certificate — Exports the certificate and is to be given to the DCP publisher
and a matching KDM is expected in return.
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4.3.22.12.2 KDM
Import and Remove KDMS. The KDM file is provided by the DCP publisher. When a
KDM is successfully imported, the key types and restrictions if any will be displayed.

4.3.22.13 Performance option

£ Options

General

Loudness
Language Detection

A Manager
Performance

yital Audio

earch Paths ditrate Threshold : ; o 1000 v+ Mbps

Quality : 0% to 500 %

Custom Quality :

Frame

JPEG 200

Import Settings  Export Settings Ok Cancel

4.3.22.13.1 Play cache buffers
Set the cache buffers to use during playback. A high value can cause high memory
consumption. Playback must be restarted for the new value to take effect. The default is
2 seconds and the maximum is 10 seconds.

4.3.22.13.2  Start playback after buffers are filled with
Start playback when selected percentage buffer is reached. This can speed up the time
to start playback.
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4.3.22.13.3 Decoder Threads
This setting controls the number of decoder threads used during playback. Default to 0
for automatic setting.

4.3.22.13.4 RS422 Settings
Enable RS422 COM port for Sony RS422 ‘9-pin’ control. The system must have a serial
COM port that supports the RS422 interface at 38400 baud, 8 bits, odd parity.

4.3.22.13.5 Jog Sensitivity
This setting controls sensitivity of the jogging control. A low value uses a progressive
range from x1/8 to x1/2, a medium value uses a range of x1/4 to x1/2 and a high value
uses the range of x1/2.

4.3.22.13.6  J2K decoder settings
Set Automatic Quality or Custom Quality for J2K decoder.

4.3.22.13.7 J2K Decoder Quality
This setting controls the J2K decoder quality by reducing the number of decoder passes.
Playback must be restarted for the new value to take effect.

0 Lossless
1-20 Virtually Lossless
21-50 Good Quality

51-100 Visually Acceptable

101-200 Visually Poor

For bitrates that exceed the performance of the CPU, the automatic control of quality can
provide an acceptable way to play back the content maintaining constant play back
speed without dropping frames. The minimum and maximum bitrate threshold defines the
bitrates that require a reduction in quality in a linear scale until the maximum threshold is
reached. After that, all frames exceeding the maximum will be capped at the lowest
quality.

4.3.22.13.8 ProRes threads
Set the number of threads for the ProRes codec.

4.3.22.13.9 HEVC threads
Set the number of threads for the HEVC codec.
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4.3.22.13.10 Frame sequence threads
Set the number of threads for Frame sequences

4.3.22.13.11 JPEG 2000 threads
Set the number of threads for the JPEG 2000 codec.

4.3.22.13.12 Frame Sequence Pre-caching
This option is for frame sequences such as DPX files. Enabling this option allows the
player to pre-cache the frames by reading ahead of playback. This option is particularly
useful when the media is located on SSD or networked drives.

Buffer size determines the read block size. This should be in multiples of the disk block
size. Default is 128 KB.
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4.3.22.14 SDI Output Options
%Y Options

General SC

Playback v Enable SDI

Overlays

Custom Video Scaling Card Type : AJA

= Default Channel :

Playlist Default Card No : 1
Loudness
Language Detection

MXF

Enable level conversion (YCbCr->RGB-Full, RGB-Full->YCbCr)

Allow VBI /VANC data

DCP / KDM Manager v Enable Digital VANC data for SD formats
Performance Force PSF for 23 to 30 fps
SDI OQutput

DVI / HDMI / Digital Audio
Capti / Subtitles Use 3G RGB Level B (otherwise use 3G Level A)

Enable Dual-Link Output (4

Asset Search Paths

. Two Sample Interleave (required for HDMI)
Shortcut Mapping

Server Se Enable HDR simulation

Force Color Space and Depth
YCbCr 4:2:2 10-bits
YCbCr 4:4:4 10-bits (3¢
YCbCr 4:4:4 12-

Source : Free Run
V-Phase :

H-Phase :

Import Settings ~ Export Settings C Cancel

4.3.22.14.1 Default Card No & Default Channel
Sets the default card and output channel to use. The maximum number of cards
supported is 2 (1 to 2) and the maximum number of channels per card is 4 (0=A to 3=D).
This can be overridden using command line variables as follows:

/i=cardno where cardnois 1 or 2.
/c=channel where channel is 0 to 3.

Example shortcut to use the first card, connector C:
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iris.exe /i=1 /c=2

NOTE: The Bluefish Supernova / S+ cards have a frame rate limitation that channel pairs
0-1 and 2-3 must have a common frequency. i.e 29.97Hz and 59.94Hz or 25Hz and 50Hz.

4.3.22.14.2  Always use dual cards for 4K/UHDTV formats
This setting forces video to appear on both cards regardless of whether the format can be
supported on 4 channels of a single card. The 4 quadrants of video will appear on BNCs
A and B on both cards. This avoids the need to change cabling depending on format.

4.3.22.14.3 CGI RGB range (otherwise uses SMPTE RGB range)
Use CGI RGB range 0-255 for 8 bits. SMPTE range is 16-235.

Allow VBI/VANC data
Allow VBI/ VANC data to appear. If this option is turned off, VITC timecode for SD and
SMPTE 334-2 708 CDP captions will not be available.

4.3.22.14.4  Force PsF for 23-30 fps on SDI output
Force the SDI output format to PsF from 23 to 30fps.

4.3.22.14.5 Enable Dual-Link Output
Enable Dual-link Output if the video is a 3G format. Dual-link pairs are always assigned
as BNC A&B and BNC C&D.

4.3.22.14.6  Use 3G Level B (defaults to 3G Level A)
Option to set to SDI 3G format to Level B. (Default is set to 3G Level A)

4.3.22.14.7 Two Sample Interleave
Enable this option if 2SI mode is required for UHD/4K formats. For the AJA range of
cards, the HDMI port requires 2SI to be enabled.

4.3.22.14.8 Color Space and Component Depth
Force a Color Space depth for the selection in the list. If disabled, native color space and
component depth is used.

4.3.22.14.9 Genlock
Genlock Setting for Digital or Analog genlock Input. Horizontal and vertical phases can be
adjusted.

4.3.22.15 DVI/HDMI /Digital Audio Options
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#2 Options

General DVI/ HDM

Default Display : =

Custom Video Scaling ¥ Enable warning before switching to full screen (if SDI card is installed)
Playlist
Loudness
MXF
HDR

Lock video to desktop refresh rate
(Desktop frequency MUST be equal or greater than the video frame rate)

Srar A oo
¥ Override graphics adapter defaults

DCP / KDM Manager

Performance Force SD (480i and 576i) resolution to :

SDI Qutput Width

0
DVI/ HDMI / Digital Audio

Double the refresh rate if below :

= Height 0.2

0 ~ Frames /second

Server Settings Force progressive scan for interlaced formats

Enable passthrough

Dolby Digital
Dolby Digital Plu

Import Settings Export Settings 0 Cancel

4.3.22.15.1  Default Display
Set Default Display.

4.3.22.15.2  Enable warning before switching to full screen
Display a warning message when switching between full screen if an SDI card is installed.

4.3.22.15.3  Lock video to desktop refresh rate
Lock video to desktop refresh rate. Desktop rate must be equal or higher than media
frequency otherwise video will drop frames.

4.3.22.15.4  Override graphics adapter defaults
Enable this option to give the highest quality video output in full screen mode if the output
can display in native video format (a HDTV connect to capable graphics card through
HDMI interface). Otherwise the default desktop resolution and frequency will be used for
full screen display.
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4.3.22.15.5 Force SD (480i and 576i) resolutions to
This will force the video to display in a support resolution. Enable this option if the monitor
does not support SD formats. Use 0x 0 to run at the native SD resolution and refresh rate.

4.3.22.15.6  Double the refresh rate if below
Set this value if the monitor does not support a low enough frequency refresh rate. The
refresh rate is doubled if the monitor’s frame rate is lower than this value. (Example: For
1080p25 video, the frame rate will double and be played back at 1080p50 if this value is
set to 30). Use a value of 0 to run at the native refresh rate.

4.3.22.15.7  Force progressive scan for interlaced formats
This forces video to run in progressive mode as some monitors do not support interlace
formats. This will produce smoother motions but create interlace artifacts.

4.3.22.15.8 Enable pass-through
This option, when selected allows compressed digital audio to pass through the PC HDMI.
Currently, the digital audio formats that can be passed through are Dolby Digital™ (AC-3)
and Dolby Digital Plus™ (E-AC-3).

NOTE: Compressed audio pass-through is only applied when the following conditions are
met:

5. Single compressed audio track is selected
6. SDI is disabled or not present
7. Attached device supports the compressed audio format

Version 9.5.1.194
BllcrAanvETA

© 2024 Copyright GrayMeta. All Rights Reserved.



124

Iris Play User Manual

4.3.22.16 Captions / Subtitles Options

#.» Options

General

rlays

tom Video Scaling
Playlist
Loudness
Language Detection
MXF

DCP / KDM Manager
Performance

SDI Output

DVI / HDMI / Digital Audio

Asset Search Paths
Shortcut Keys Mapping
Server Settings

¥ Always use solid text background with Transparency 75

Primary PAC Subtitle Code Page :

SON subtitles frame rate:

~
-

Font Size : Medium ~

Specify on demand >

Secondary PAC Subtitle Code Page: | atin -

29.97 (Drop Frame) ¥

Enable pre-processing of captions / subtitles
Use captions / subtitles from video source file
Enable deep scan (slow)

Enable auto load external captions / subtitles files with matching name
Show hidden captions / subtitles (this setting will take effect after a video file is loaded)
Ignore captions / subtitles positioning
Show captions / subtitle times as TCR

Use CTC timecode

Automatically select external subtitle when loaded

Emulate Roll-up captions / subtitles in Subtitle Viewer Tool Window (if turned off, rolled up text will not be shown)
Use media timebase for SRT captions/subtitles

Warn user of SCC captions text display time being less than number of frames specified by this value

~

Captions Pre-roll (ms) 1

Remember the last live caption selection

Use Time ( t:

Use Timecode Offset :

Hour  Min Sec

Enabled

Storage Folder :

Import Settings ~ Export Settings DK Cancel

4.3.22.16.1  Always use solid text background
Enable this option to use solid text background. Set the Background Transparency
percentage if this option is enabled.

4.3.22.16.2 Font size
Set the font size to small, medium and large.

4.3.22.16.3 PAC Subtitle Code Page
The PAC subtitle format supports different code pages for extended character sets. Set
this to the required language code page for the subtitles to appear correctly.
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4.3.22.16.4  Secondary PAC Subtitle Code Page
Set the secondary PAC code page.

4.3.22.16.5 SON subtitle frame rate
Specifies the default frame rate for SON files.

4.3.22.16.6  Enable pre-processing of captions / subtitles
This setting will determines captions / subtitles pre-processing. If it is enabled, the
captions / subtitles are extracted and shown in the Subtitle Viewer tool window. If the
setting “Use captions / subtitles from video source file” is enabled, then embedded
captions / subtitles, such as EIA608, CEA708, Teletext and so on, will be extracted and
they will be shown in the Subtitle Viewer window.

For deep scan setting, it allows for a more thorough scan of embedded captions. If
certain captions and subtitles are embedded in the video stream and are located near the
end of the file, then the player’s quick scan process may not find these captions as they
only scan a certain amount of data from the beginning of the file. Enable this option to
perform a full scan but it may be slow for large files since this will force a scan of the
whole file. Note, the time to extract the subtitles will be the same no matter if deep scan is
turned on or off, because deep scan is used for detecting subititles.

The setting to “Enable auto load external captions / subtitles files with matching name”
means that upon loading a video file, any sidecar captions / subtitle files that have
filenames that match the video file will also be loaded. Therefore, opening a video file
called myfile.mov will also open a subtitle file called myfile.srt, if it exists in the same
location.

4.3.22.16.7  Show hidden captions/subtitles
Show hidden captions/subtitles. This setting will take effect after a video file is loaded. It
is used to enable captions/subtitles that are embedded in the video stream but are not
signaled for output to the display. This option forces them to the display.

4.3.22.16.8 Ignore captions/subtitles positioning
Ignore captions/subtitles positioning and places them at the bottom of the display.

4.3.22.16.9 Show captions / subtitle times as TCR
Shows TCR timecode instead of time in the Subititle Viewer windows.

4.3.22.16.10 Use CTC timecode
Uses the CTC timecode track as the reference of captions/subtitle display.

4.3.22.16.11 Enable auto load external captions / subtitles files with matching name
Automatically loads captions / subtitles files that have the same file name as the video file

4.3.22.16.12 Emulate Roll-up captions / subtitles in Subtitle Viewer Tool Window
Roll up captions / subtitles are shown in the Subtitle Viewer Tool Window. This means
that the window will show text that includes previous rolled up text.
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4.3.22.16.13 Warn user of SCC captions text display time being less than number of frames
If enabled, checks whether the display duration of the text is less than this number of
frames.

4.3.22.16.14 Caption Pre-roll (ms)
By default, double clicking the start or end times in the captions viewer causes the player
to seek to the exact position denoted by the start or end times. This setting will apply a
negative offset to the start and end times. Therefore, specifying a value of 1000 ms
means that the seek will occur 1000 ms in advance of the actual start or end time of the
captions text.

4.3.22.16.15 Remember the last live caption selection
This setting will remember the last live caption type that was selected and upon opening
a video file, Iris will automatically select the last remembered type. For example, if the
video is showing 708 Service 1 captions, then opening a new video will cause Iris to
select 708 Service 1 captions rather than the default of 608 CC1 captions.

4.3.22.16.16 Start offset
Use time offset (in milliseconds) or Timecode offset (HH:MM:SS:FF) to offset the timings
of the captions. Negative values can be used to offset them to an earlier time.

4.3.22.16.17 Cache
Enable and set the cache storage folder. This option allows pre-processing of captions to
save an .AST file in the cache folder so that it can be reused on subsequent calls to re-
process the file, hence reducing the processing time for startup.
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4.3.22.17 Assets Search Paths

o Options

n Wormhole

Import Settings ~ Export Settings Cancel

This sets the asset search paths for the IMF/ DCP supplemental folders. Assets are searched
from the top downwards. Click the “Add” button to add a parent folder to search from.
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4.3.22.18 Shortcut Keys Mapping

o Options

Profile : Default

Manager Sign In
Sign Out

nt Details

Add Predefi

Add Predefi

Add Predefi

Add Predefined Annotation M

Add Predefined Annotation

Add Predefined Annotation 9 Alt+9
nnotation e Alt+0

Add Predefi notation e Alt+QemMinus

Add Predefined Annotation 2 Alt+OemPlus

x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x

Import Settings Export Settings Cancel

4.3.22.18.1  Profile
Choose a Shortcut Key Profile: Adobe, Default, Final Cut Pro and User Defined.

4.3.22.18.2 Command
This shows all commands with the Shortcut Key. Click Set to change the command
with a new Shortcut Key. Clear will remove the shortcut key from the command.
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4.3.22.19 Server Settings

£ options

ires application restart) : K

utk - A y sign in to Iris using current Window:

Server Settings

Import Settings ~ Export Settings

4.3.22.19.1  Server Settings
This specifies the database connection credentials need to be imported. These are in
a file with the .dbs extension and are generated by Iris Admin GUI. For further
information on generating the .dbs file, please consult the Iris Admin user manual.

4.3.22.19.2 Hardware License From Server
This allows a Customer ID to be specified in order to License Iris for use in stand
alone playback mode. A local license can also be used for the same purpose (see
section 4.3.25) and if both types of licenses exist, the local license takes precedence.

The button labelled “Check Customer ID” enables the validity of the Customer ID to
be checked and will also report the start and end dates of the license validity period.

Note: When the Customer ID has been changed, Iris needs to be restarted for the
change to take effect.
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4.3.22.19.3 Active Directory Settings
In this section there is an option to allow an Active Directory user to automatically
sign in to Iris. When this option is enabled and the current Windows user has signed
in using Active Directory credentials, Iris can use this user to automatically sign in.

4.3.22.20 Import/ Export Setting
The entire options settings can be imported and exported to and from a .json file.

4.3.23 File Properties

2 File Properties

<audio_track_c

<timecode_track_count di
itle_track_count disp

werl wirlth

This option displays a XML file containing all the properties of the currently loaded package. It is
useful as a machine-readable file and can be exported by using the Save As button.
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4.3.24 License Information

HIII GrayMeta ActiveX Control. Version 7.5.0.2133
Copyright (C) 2019. GrayMeta, Inc.

Machine Host ID: 2644998112

License Host ID: 4255547222

Licensed to user: Chi

Issue date: Wed Mar 20 18:19:29 2019
Expiry date: Mone (Permanent)
Restrictions: None

Playback enabled: Yes

Encrypted Advanced Test Patterns: Yes
UHD and 4K frame sizes: Yes

Digital Cinema Packages (DCP): Yes
Encrypted Digital Cinerma Packages: Yes
Serial Digital Interface (SDI) playback: Yes
Frame sequences (DPX, TIFF, EXR): Yes
RS422 Sony 9-pin remote control: Yes
‘Waveform monitor: Yes

Vectorscope: Yes

Video scaling for PC and SDI outputs: Yes
Audio waveform monitor: Yes

Audio phase meter: Yes

Captions viewer: Yes

Audio level meter: Yes

Audio router: Yes

Audio loudness measurement: Yes
Interoperable Mastering Format (IMF) packages: Yes
Play list: Yes

Asset Metadata: Yes

Annotations and Message Board: Yes
Vidcheck QC Integration: Yes
Spectrascope: Yes

Venera QC Integration: Yes

oK

This shows the ‘Offline hardware’ license information (expiry time and the Host ID of the

machine).

Each license needs to be registered to a machine (in particular, the Host ID). Only one Host

ID can be registered at any one time for each license.

4.3.25 Import license
Select the license file (.lic) to import.

4.3.26 Help
This displays the User Manual.

4.3.27 About

Version 9.5.1.194

© 2024 Copyright GrayMeta. All Rights Reserved.

llcrAanvETA



132

Iris Play User Manual

GrayMeta Iris
Version 2.1.0.14 (64-bit)
Copyrigh rayMeta, Inc.
All rights

End-user license agreement  Copyright

Before downloading, please accept the following End User License Agreement and tick the
| Agree checkbox at the bottom of this page.

END USER LICENSE AGREEMENT

This copy of an Archimedia Software Product ("the Software Product”") and accompanying
documentation is licensed and not sold. This Software Product is protected by copyright laws and
treaties, as well as laws and treaties related to other forms of intellectual property. Archimedia
Technology Inc. or its subsidiaries, affiliates, and suppliers (collectively "Archimedia”) own
intellectual property rights in the Software Product. The Licensee's ("you" or "your"} license fo
download, use, copy, or change the Software Product is subject to these rights and te all the
terms and conditions of this End User License Agreement ("Agreement”).

Acceptance

YOU ACCEPT AND AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT BY
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4.4 GrayMeta Iris Keyboard Shortcuts

Button Description

Ctrl + O Open a MXF file to play
Ctrl + Space Pause

Ctrl + Left Rewind/previous frame
Ctrl+P Play

Ctrl + Right Fast forward/next frame
Ctrl + S Stop

Ctrl + R Reset mark-in/out markers
Ctrl +1 Set mark in

Ctrl + U Set mark out

Ctrl + L Enable/disable loop mode
Alt + Up Increase volume

Alt + Down Decrease volume

Alt + Del Mute/unmute

Ctri+ F Swap field order

Ctrl+Y Enable overlay

F4 Toggle RS422 remote focus
F6 Toggle between TCR/CTC/TIME/FRAME mode
F7 Display auto size

F8 Display 1:1 pixel size

F9 Hardware mode full screen (default monitor)
F10 Search

F11 Window mode full screen
ESCAPE Exit full screen mode

F1 Show about box
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5 Appendix A: SDI playback Card

With an optional SD/HD-SDI PCI-Express I/O card, the Master Player provides 8, 10 or 12-bit
uncompressed baseband video and up to 16 channels of 24-bit PCM audio through BNC
connectors for SDI monitoring, distribution or VTR dubbing. Please ensure the card driver and
firmware are installed from the installer before use.

The SDI output supports both SD and HD formats:

e Supports SD 720x480i to HD 1920x1080p59.94 (1-Channels I/0O)

e Supports 2K to 4K (4-Channels 1/0O)

e Time code for SD using D-VITC or ATC-VITC and ATC-LTC.

e Time code for HD using ATC-VITC and ATC-LTC (Digital Ancillary Time Code) only
e Provides 8, 10 or 12-bit uncompressed baseband video

e Up to 16 channels of 24-bit PCM audio

Non-standard picture sizes will be centered with black borders.
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6 Appendix B: Computer HDMI Output

One of the unique features of the GrayMeta Iris is the ability to drive the HDMI interface in full-
screen mode at the native resolution and frame rate of the file content. When viewed on a true
HDTV, video motion will appear as intended without any cross frame-rate interference. Picture
resolution can also be scaled to whatever your HDTV supports. This is the most cost effective way
of displaying the true quality of your video without the use of an SDI card.

Checking if the resolution and refresh rate is supported

a) Right click on the Desktop and select Screen Resolution.
b) Select Advanced Settings in Display properties.

[E=8 Eon ==

G‘U B « Appearance and Personalization » Display » Screen Resolution v [ 49 | Search Controt Pone »

Change the appearance of your displays

el -

Digplay: [Lveer  ~
Resolution: “920 x 1080 (recommended)
QOrientation: l Landscape v ‘

Multiple displays: | Show desktop onlyonl ~

This is currently your main display. Advanced settings

oK [ Cancel |

c) Select List All Modes in Adapter tab.
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PnP-Monitor (Standard) and ATI Radeon HD 5670 Properties (=
Color Management | & Catalyst Control Center
Adapter ‘ Monitor I Troubleshoot
Adapter Type

| ATIRadeon HD 5670

Adapter Information

Chip Type: AMD Radeon Graphics Processor (0x68D8)
DAC Type: Internal DAC{400MHz)

Adapter String:  ATI Radeon HD 5670

Bios Information: 113-3E151HDP-EP1

Total Available Graphics Memory: 4855 MB

Dedicated Video Memory: 1024 MB

System Video Memory: 0MB

Shared System Memory: 3831 MB
| List All Modes

d) Here is the list of resolution and refresh rate supported by the current graphics card and
attached monitor. For best performance, True Color (32 bit) color mode should be selected.

List All Modes ==

List of valid modes

1920 by 1080, 256 Colors, 29 Hertz (Interlaced) -
1920 by 1080, High Color {15 bit), 50 Hertz

1920 by 1080, High Color {15 bit), 60 Hertz

1920 by 1080, High Color {15 bit), 55 Hertz

1920 by 1080, High Color (16 bit), 25 Hertz (Interlaced)

1920 by 1080, High Color (16 bit), 30 Hertz (Interlaced)

1920 by 1080, High Color (16 bit), 29 Hertz (Interlaced)

1920 by 1080, True Color {32 bit), 50 Hertz
15920 by 1080, True Color (32 bit), 60 Hertz &

PooK |[ Cancel ]

1. Adding custom resolutions and refresh rates

The method to add custom resolutions and refresh rates for modes not supported natively by
the graphics card or monitor can vary between graphics card manufacturers and models.
Critical damage can occur while trying to exceed the capabilities of the graphics card.

To ensure the format is supported and is working, manually switch the desktop to the required
format to see if the Windows desktop is displayed correctly. The Player can only switch to
modes that are supported by Windows display.

2. Special formats

There are some common formats that will not be supported unless you have a high-end HDTV
monitor and graphics card.
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o 576i50/ 480i59.94 / 486i59.94. These SD formats use 720 pixel widths and may require
manual override (Advanced Options Box) to 800x600 resolution. This gives the minimum
amount of oversampling artifacts if the native mode is not supported.

e 720p23.98 /720p24 / 1080p23.98 / 1080p24 / 1080p25. These low frequencies require a
high-end HDTV usually labeled as supporting ‘1080P24’ cinematic format.

Some monitors may not support interlaced formats. Enabling the option ‘Force progressive scan
for interlaced formats’ in the Advanced Options will force formats 1080i50 to 1080p50 and
1080i59.94 to 1080p59.94. This will NOT de-interlace the picture to form a progressive picture.
Only the refresh rate will run twice as fast to enable viewing on the monitor.

When in windowed mode and the picture is resized to fit the window, interlace artifacts may be
visible due to the sub-sampling aliasing of the interlaced picture. To avoid this artifact, view the
playback as ‘Actual Size’ or in full screen mode or by enabling the BOB de-interlacer. In full
screen mode, an interlaced picture will be de-interlaced by the monitor if it can switch to an
interlace mode.
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7 Appendix C: 4K SDI configuration — Bluefish444

Supernova S+ Cards

When 4K playback through dual SDI cards is required, both cards must have the “Quad_out”

firmware loaded so that they can be genlocked together for synchronous operation.

The firmware can be loaded from the:

\Bluefish444 Epoch_Supernova\Driver x_x_x_x\Firmware\SuperNova folder. Run the

corresponding installer and select the card number to program. After loading, the computer must be

powered down and cold rebooted (removal of power for 30 seconds).

The following diagram shows the wiring for dual Supernova S+ cards.

Archimedia 4K Quad link 3G SDI card wiring. If your cards have a different number of
BNCs, this is the wrong diagram. This view is from the back of the Archimedia 4K / UHD
Workstation. Requires four BNC cables to 3G SDI destination, and one short BNC jumper.

ArchimediaSDI  TOP  Archimedia SOI
Options tab card 1 Options tab card 2
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Bluefish444 docs. mOpu. °oum“s_
Card 1 BNC1 (out), o
genlock to card 2.
Card 1 BNC 2 (out). i
BNC 4 (out).
Card 1 BNC 3 (out). 1
BNC 5 (out).
Card 2 BNC 2 (out). 5
BNC 4 (out).
Card 2 BNC 3 (out). :
BNC $ (out).
Card 2 BNC 6 (in) e
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8 Appendix D: 4K SDI configuration — Bluefish444

Neutron Cards

When 4K playback through dual SDI cards is required, both cards must have the “3 Out”
firmware loaded so that they can be genlocked together for synchronous operation.

The firmware can be loaded from the:

\Bluefish444 _Epoch_Supernova\Driver_x_x_x_x\Firmware\Neutron folder. Run the corresponding
installer and select the card number to program. After loading, the computer must be powered down

and cold rebooted (removal of power for 30 seconds).

The following diagram shows the wiring for dual Neutron cards.

4K SDI configuration - Neutron Card

Archimedia 4K Quad link 3G SDI card wiring. If your cards have a different number of
BNCs, this is the wrong diagram. This view is from the back of the Archimedia 4K / UHD
Workstation. Requires four BNC cables to 3G SDI destination, and one interlock cable

InD EJO:: Inr_]Dw
ArchimediaSDI  TOP  Archimedia SOI
Options tab card 1 Options tab card 2

Of.. O

Quadrant 1 with audio

o Obt=
OfH O

Duplicate quadrant 1
with audio

The following picture shows interlock cabling for dual Neutron cards.
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BNC numbers foundin | 2" chime SOI“
BNC 1 (out) 0
BNC 2 (out). 1
Embedded audio on
quadrant 1 only
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9 Appendix E: Command Line Interface (CLI)

Usage

Argument

i

c

P

startframe

starttc

startctc

starttime

markinframe
markoutframe

markintc

markouttc

markinctc

markoutctc

markintime
markouttime
imagesequencefolder
video

audio

subtitle
enableembeddedaudio
enableembeddedsubtitle
enablesubtitlepreprocessing
enablesubtitledeepscan
volume

addtoplaylist

repeatmode

Version 9.5.1.194
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Function
SDI Card Number (if available)

SDI Channel Number (if available)

COM Port Number (if available)

Start and jump to frame “n”

Start and jump to timecode “hh:mm:ss:ff’

Start and jump to control timecode “hh:mm:ss:ff’

Start and jump to time “hh:mm:ss.ms”

Sets mark in frame “n”

Sets mark out frame “n

Sets mark in from timecode “hh:mm:ss:ff’

Sets mark out from timecode “hh:mm:ss:ff’

Sets mark in from control timecode “hh:mm:ss:ff’

Sets mark out from control timecode “hh:mm:ss:ff’

Sets mark in from time “hh:mm:ss.ms”

Sets mark out from time “hh:mm:ss:ms”

Set the image sequence root folder

Start with selected video file
Start with selected audio file
Start with selected subtitle file
“1” to enable embedded audio

“1” to enable embedded subtitle

“1” to enable pre-processing of caption files

“1” to enable deep scan of subtitles

Set the volume level. 0 is maximum, -100dB minimum

“1” to add video to playlist

“repeat_current”, “repeat_al

repeat_off”
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audiorouting

mute

unmute

deleteimportreport

importvidchecker
importvenerareport
importbatonreport
importaurorareport
importgscanreport
closefile

dockinglayout

“-1,-1;i,0” where i is the input channel and o is the
output channel mapping. Use -1,-1 to reset all
channels. Each mapping is separated by a semi-colon.

“-1” to mute all channels, “1,2” to mute channels 1 and
2 only

“-1” to unmute all channels. “1,2” to unmute channels 1
and 2 only.

Automatically delete the imported XML report when
video content is closed.

Import Vidcheck Vidchecker XML report file
Import Venera Pulsar XML report file
Import Interra Baton XML report file.

Import Tektronix Aurora XML report file.
Import QScan XML report file.

Closes the currently loaded file.

Name of stored layout to load

All commands are preceded with the “/” (forward slash) character. The command and value is

7]

separated by the

(equals) character. Each command and value pair must be separated by a

space. All text string values (like filename or paths) that contain a space must be enclosed with

double quote.

Example:

To launch Iris from the CLI, and add the file to the playlist and start the playback at frame 100, run

the following:

Iris.exe /video="my filename.mov” /addtoplaylist=1 /startframe=100

Version 9.5.1.194

© 2024 Copyright GrayMeta. All Rights Reserved.

BllcrAanvETA



Iris Play User Manual

10 Appendix F: Playing IMF Files

& Open IMF package - ASSETMAP.xml —-Ox

i 5 Assets Search Paths

[ ]

CPL - 1 Complex CPL Test

Cancel

To open an IMF package, open the ASSETMAP.xml file. This is the highest-level hierarchy of the
CPL(s) (Composition Play List) in the package. You can also open each CPL file separately.

The Iris IMF viewer displays a time line of how the package is built up to make a segment which in
turn makes up a CPL. The colored lines indicate where the joins of video, audio and caption source
files occur and their relative and absolute positions are listed in the grid control.

The left hand ‘tick’ icons indicates the validity of the checksum against the checksum stated in the
package.

To play the entire ‘Segment’, select the CPL group and then press OK.

Version 9.5.1.194
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& Open IMF package - ASSETMAP.xm

B8

CPL_3 7-4f90-b355. ed 3d68.xm
@ Segment (urn:uuid:al016932-1520-49e6-8d 7c-fde07fcf48d9)
Videos
m, NetflixComplexIMFTest_00.mxf

Filename

type

Id

EditRate

Audios
4. NetflixComplexIMFTest_5.1 Surround_00.mxf

Filename

eren_0.mod

CPL Details

Selecting the ‘Tree View’ icon displays the CPL information as an expandable tree. This provides a

more in-depth display of its metadata.

-0

Search Paths

From this view, the required group of video and audio can be chosen for playback by double
clicking on the parent item encapsulating the video, audio and subtitle assets. As with the CPL

dialog box, optional audio streams may also be selected by use of CTRL and left click. Note that the
chosen audio streams are not required to be within the same playlist as the video. Furthermore, it is

possible to select more than one audio stream from different playlists. Press OK to play the entire

segment.
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11 Appendix G: Captions/Subtitles Formats

The player can support both captions/subtitles that are embedded in the video file and
captions/subtitles that exist on separate files. The following is a list of all the formats that are
currently supported:

¢ Internal/ Embedded captions/subtitles

3GPP Timed Text (.TX3G)

EIA-608 (DVTCC SCTE128) text stream
EIA-708 (DVTCC SCTE128) text stream
EIA-608 (DVTCC SCTEZ20) text stream
EIA-708 (DVTCC SCTEZ20) text stream
EIA-608 (Ancillary CDP) in MXF
EIA-708 (Ancillary CDP) in MXF
Teletext

¢ External/ Embedded captions/subtitles

Comma Separated Files (.CSV)
D-Cinema Interop (.XML) external files
DLP Cinema (.XML)

European Broadcasting Union (.STL)
Scenario Closed Captions (.SCC)
Screen Electronics (.PAC)

SMPTE 428-7 (.XML)

Sonic Solutions (.SON)

Spruce (.STL)

Subrip (.SRT)

Timed Text (.DFXP)

iTunes Timed Text (.ITT)

Videotron Lambda Cap (.CAP)

Web Video Track (.VTT)

If captions/subtitles are requested, the opening of a video file will result in existing text streams to
be scanned for captions/subtitles. External captions/subtitles files will also be processed.

After the video has been loaded, any captions/subtitles will be displayed in the Captions/Subtitles
Viewer (see below) and also in the player. If there is more than one captions/subtitles track, then
any of them can be selected from the right-click context.
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Editing feature that enables captions/subtitles in the European Broadcasting Union STL format (not
to be confused with the Spruce STL format) to be modified. This feature is enabled when the
captions/subtitles viewer is displaying EBU STL captions/subtitles.

This section describes how subtitles in EBU STL format can be edited.

Right click on the captions/subtitle editor and options for Edit, Set Current Timecode, Apply
Changes, Save and Save As will be available.

d

iz .
and

1w hawe been moved, renamed, or delets
Werify that the link. points ta the correct Ale
location,

When the Edit option is selected on a row in the captions/subtitles viewer, edit mode is initiated.
Note that right clicking to choose edit from the context menu is location dependent, so right clicking
a row under the time in column and selecting Edit will initiate Edit Mode for Time In. Right clicking
under the Time Out column and selecting Edit will initiate Edit Mode for Time Out. Similarly, editing
the text requires right clicking under the Text column and selecting Edit.

Once in Edit Mode, the new information can be typed in and the new changes are inserted by
pressing Enter or clicking away. The Escape key can be used to cancel the edit. However, the
changes will not be reflected in the player until the Apply Changes option is chosen from the context
menu.

Rather than typing in time in and time out values, the current timecode indicated in the player can
be used. This is carried out by selecting the Set Current timecode option in the context menu. To
set the time in to use the current timecode, right click a row under time in column and select Set
Current Timecode to set the player’'s timecode as the new Time In value. To set the current
timecode for time out, right click under the time out column and choose Set Current Timecode in the
context menu.
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There are 5 shortcut keys that can also be used to edit. First, a row on the captions/subtitles viewer
needs to be selected by a single left click. It will be highlighted in green. When the row is selected,
the following shortcut keys can be used:

e CTRL + 1 - Select Edit Mode for the Time In column of the selected row.

e CTRL + 2 — Select Edit Mode for the Time Out column of the selected row.
e CTRL + 3 — Select Edit Mode for the Subtitle Text column of the select row.
o CTRL + 4 — Set the Time In value to be the player’s current timecode.

e CTRL + 5 — Set the Time Out value to be the player’s current timecode.

Note that the above operations require the Apply Changes context menu option to be carried out for
the changes to be reflected in the player.

The edited STL can be saved back to the original STL file or saved to a new file. The context menu
options for ‘Save’ and ‘Save As’ will perform these respective functions.
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12 Appendix H: 39 Party XML QC Report Import

Iris currently supports the following automated QC reports:

e Vidcheck Vidchecker .xml files

e Venera Pulsar .xml files

e [Interra Baton .xml files

e Tektronix Aurora .xml files

o Telestream Vidchecker .json files
e Telestream Cloud .json files

o GrayMeta Iris .json and .xml files

Each QC report identifies positions in the file where it highlights an issue with the content or file
metadata or its structure. Importing the report into Iris along with the media file allows easy
verification of the alerts.

To use the QC import feature, first load the source media file that has been analyzed by the
automated QC application into a Project. Then from the Open QC Report context menu, select the
matching report file.

AS-11 UK DPP V4.3 HD AVC-] 16 Track Single Part (created at 2014-03-18700:00:00)

This template covers the general requirements for file based HD content to the AS-11 UK DPP Technical Standards

V43, Please see the Digital Production Partnership website for specific versions for UK broadcasters. Note that the
for

g and surround scund audia tracks and

Video Layout Info (6) Timecode range before 10:00:00:00 of the video not tested.
‘Audio Layout Info (7) Timecode range before 1000:00:00 of the audio not tested.
‘Audio Layout Info (8) Timecode range before 10:00:00:00 of the audio not tested.

“
10,00.52.23 *1
B 1324 1

“
«
«
«
«
«
«
“
“
-
«
«
«
“
“
590

Audio Layout Info (9) Timecode range before 10:00:00:00 of the audio not tested.

‘Audio Layout Info (10) Timecode range before 10:00:00:00 of the audio not tested

No Flashing (100) Passed - no harmiul flashes were detected. Tested to [TU-R BT 1702/Ofcom recommendations for
luminance flashes / extended flashing / saturated red flashes.

BEPZY -7 RENRTR 5 RERNRE -5 | 1501

Frame 1324 (10:00:22:23) to 1376 (10:0025:00) -
Individual Peak Audio Level (86) [Audio stream 1 channel(s) 11-16] Audio peaks detected, Maximum in this section
was 0.1 g8 on channel 11

After importing, the Message Board and Annotation Message windows will be populated with the
detected alerts. The colors in the annotation tabs are specific to the QC vendor. The same color
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alerts are placed in the time-line control as diamond markers. You can jump to the alert position by
clicking the diamond markers or by double clicking the annotation tabs. The imported information is
automatically saved for the media in the project.

A Vidchecker XML report file can also be imported via the command line using option:
/importvidchecker="file.xml’

A Venera Pulsar XML report file can also be imported via the command line option:
/importvenerareport="file.xml”

An Interra Baton XML report file can also be imported via the command line option:
/importbatonreport="file.xml”

A Tektronix Aurora XML report file can also be imported via the command line option:

/importaurorareport="file.xml”

Version 9.5.1.194
149 BllcrAanvETA

© 2024 Copyright GrayMeta. All Rights Reserved.



Iris Play User Manual

13 Appendix I: Known Issues

We highly recommend that you don’t use a mixture of Iris 6.x and Iris 7.x clients connected to
the same Iris Sever. There is a known problem in an environment consisting of a mixture of
Iris 6.x and Iris 7.x clients and use of Active Directory groups. The problem manifests itself
when user 1 adds a group to a project in Iris 7.x. User 2, who is a member of that group, logs
in using Iris 6.x but User 2 will not see the project. The workaround is that User 2 has to log in
using Iris 7.x for the project to appear. However, once this has been done, User 2 can go
back to Iris 6.x, log in and now see the projects.
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